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Pre-Installation Checklist 
You can use the following checklist to help you prepare your environment for the deployment of 
Parallels Mac Management for Microsoft SCCM. The Reference column contains links to topics 
describing how to accomplish a corresponding tasks. Most of these topics are located in the 
Installation Requirements (p. 12) and some other sections that follow this one. 

 Category Task Reference 

 
General 
requirements 

Check the requirements for supported 
SCCM, Windows, and OS X versions. 

General Requirements (p. 12) 

 Parallels Proxy .NET Framework 4.0 is required .NET Framework 4.0 (p. 13) 

 Parallels Proxy Proper Distribution Point Role Configuration Distribution Point Role Configuration 
(p. 13) 

 Parallels Proxy Verify the IIS settings on the Distribution 
Point Server 

IIS Settings on the Distribution Point 
Server (p. 13) 

 Parallels Proxy Check Configuration Manager Boundaries 
Configuration 

Configuration Manager Boundaries 
Configuration (p. 24) 

 Parallels Proxy Configure Windows Firewall Configuring Windows Firewall (p. 25)

 Parallels Proxy Configure OS X Firewall Configuring OS X Firewall (p. 68) 

 Parallels Proxy Verify that your network environment is 
configured properly 

Network Configuration (p. 14) 

 Parallels Proxy Date and Time Synchronization check Date and Time Synchronization (p. 
14) 

 
Parallels NetBoot 
Server 

Optional component. Needed for the OS X 
Image Deployment functionality. 

Parallels NetBoot Server 
Requirements (p. 14) 

 

Parallels OS X 
Software Update 
Point 

Optional component. Needed for the OS X 
software update functionality. 

Parallels OS X Software Update 
Point Requirements (p. 15) 

 
Parallels MDM 
Server 

Optional component. Needed for the Apple 
DEP functionality. 

Parallels MDM Server Requirements 
(p. 15) 

 Other Verify Reporting Point Role, optional, but 
needed to view reports 

The Reporting Functionality 
Requirements (p. 15) 

 Other Verify Report Viewer, optional, but needed to 
view reports 

The Reporting Functionality 
Requirements (p. 15) 

 Other Review the ports used by Parallels Mac 
Management 

Communication Ports and Protocols 
(p. 16) 

 User rights 

Verify user rights requirements.  

Note: This is a very important step 
to ensure a successful installation of 
Parallels Mac Management. 

User Rights Requirements (p. 17) 

The KB article at 
http://kb.parallels.com/121569 
provides additional information on 
how to set up a service account for 
proper PMM installation. 
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 PKI integration 

Optional, but needed if you would 
like to integrate Parallels Mac 
Management with a Public Key 
Infrastructure (PKI). 

Integrating Parallels Mac 
Management with PKI 

 
 

Installation Requirements 
Before proceeding, please read this section to learn about system requirements for installing Parallels Mac Management 
for Microsoft SCCM.  

The section begins with General Requirements and then describes requirements for installing individual Parallels Mac 
Management components. It concludes with describing communications ports and protocols used by Parallels Mac 
Management.  
 

General Requirements 

Supported SCCM Versions 

Parallels Mac Management supports Microsoft System Center Configuration Manager 2012, 2012 
R2, and newer. Please make sure that you have the latest service pack and critical updates 
installed. 

Supported Windows Versions 

Windows components of Parallels Mac Management follow the same system requirements as the 
Microsoft System Center components.  

Supported OS X Versions 

The following versions of OS X operating system are supported:  

• OS X 10.7 Lion 

• OS X 10.8 Mountain Lion 

• OS X 10.9 Mavericks 

• OS X 10.10 Yosemite 

• OS X 10.11 El Capitan 

• macOS 10.12 Sierra 
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Parallels Configuration Manager Proxy Requirements 

The following subsections describe requirements for a server on which the Parallels Configuration 
Manager Proxy component will be installed. 
 

.NET Framework 4.0 

The server on which Parallels Configuration Manager Proxy will be installed must have the .NET 
Framework 4.0 installed. 
 

Distribution Point Role Configuration 

Verify the Distribution Point role configuration: 

1 In the Configuration Manager console, navigate to Administration / Overview / Site 
Configuration / Servers and Site System Roles.  

2 Select your site in the right pane.  

3 In the Site System Roles pane, right-click the Distribution Point role and then click 
Properties in the context menu.  

4 In the Distribution Point Properties dialog set the following options: 

• On the General tab page, select HTTP or HTTPS in the Specify how client computers 
communicate with this distribution point group. If you'll be using Public Key Infrastructure 
(PKI) for authentication, you need to select HTTPS. The PKI integration is described in the 
Integrating Parallels Mac Management with PKI section (p. 25). 

• If you've selected HTTP, check the Allow clients to connect anonymously option. 
 

IIS Settings on the Distribution Point Server 

To verify the Internet Information Services settings on the Distribution Point Server, do the following: 

1 Open Start > Administrative tools > Internet Information Services (IIS) Manager. 

2 Navigate to Sites / Default Web Site.  

3 Click the Default Web Site and double-click Authentication in the IIS section. 

4 Check that Windows Authentication is enabled. 

5 Click the Default Web Site and double-click Authorization Rules in the IIS section. 

6 Check that authorization is allowed to all users 
 

Configuration Manager Boundaries Configuration 

See Configuring Configuration Manager Boundaries (p. 24) for complete details. 
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Windows and OS X Firewall Configuration 

See Configuring Windows Firewall (p. 25) and Configuring OS X Firewall (p. 68). 
 

Network Configuration 

For details on how your network environment should be configured, see the following KB article: 
http://kb.parallels.com/118518 

In addition, verify that your Mac computers have network access to SCCM site servers. Use the 
traceroute command in OS X and tracert in Windows to verify network access. Access to 
the following servers needs to be checked: 

• The server that will host Parallels Configuration Manager Proxy 

• The Active Directory server 

• The Management Point role server 

• The Distribution Point role server 

Check the IP address of the DNS server in OS X network preferences on a Mac: 

1 In OS X, open System Preferences / Network. 

2 Click the Advanced button. 

3 Click the DNS tab.  

4 In the DNS Servers section, add the DNS server address if it's missing. 
 

Date and Time Synchronization 

Date and time must be synchronized between servers running Configuration Manager, Parallels 
Configuration Manager Proxy, Active Directory, Management Point, Distribution Point, and all Mac 
computers that you want to manage. If date/time is out of sync, the Parallels Mac Client registration 
procedure and Mac management operations (specifically, policy downloading and updating) may 
not work correctly. 
 

Parallels NetBoot Server Requirements 

Parallels NetBoot Server must be installed on a server where the Distribution Point role is installed. 
The server must also meet the following requirements: 

• Must be a PXE service point. 

• Must have WDS installed and running. If both WDS and DHCP are installed on the same server, 
the Do not listen on port 67 option must be selected in the WDS service properties. 

• Must have BITS 4.0 installed. 
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Additionally, the user account that you'll use to configure the Parallels NetBoot Server must have 
sufficient privileges. See the following KB article: http://kb.parallels.com/117937 

Depending on your network topology, you may also need to configure UDP traffic forwarding, so 
DHCP broadcast packets from Mac computers can reach the DHCP server and the NetBoot 
server. For the complete information about setting up the network environment for NetBoot, please 
read the following KB article: http://kb.parallels.com/118518.  

Please also see Communication Ports and Protocols (p. 16) for the list of ports used by NetBoot 
Server. 
 

Parallels OS X Software Update Point Requirements 

In order to install the Parallels OS X Software Update Point component, the following requirements 
must be met: 

• Windows Server Update Services (WSUS) must be installed and configured for local publishing 
of updates. Please see the following page on the Microsoft's website for more info: 

https://msdn.microsoft.com/en-us/library/bb902479 

On the web page, refer to the "To set up the update server for locally-published content" 
section for instructions. 

• A user account must be configured for running the Parallels OS X Software Update Point 
service. The account must have administrative rights on the local sever and must be a member 
of the WSUS Administrators group. 

• The WSUS signing certificate must be deployed and accessible by the user account that will be 
running the Parallels OS X Software Update Point service. Please see the following KB article for 
more information: http://kb.parallels.com/en/123756. 

 

Parallels MDM Server Requirements 

The Parallels MDM Server component must be installed on a server that meets the following 
requirements: 

• Must be located in DMZ. 

• Must be accessible from the server where the Parallels Proxy component will be installed (p. 
13). 

 

The Reporting Functionality Requirements 

The Reporting Point role and report viewer described below are not required in order to install 
Parallels Mac Management, but are needed for the reporting functionality to work. 
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Reporting Point Role 

To verify that the Reporting Point role is installed: 

1 In the Configuration Manager console, navigate to Administration / Overview / Site 
Configuration / Servers and Site System Roles.  

2 Verify that the Reporting services point role exists. 

3 Navigate to Monitoring / Reporting / Reports.  

4 Right-click any of the available reports and check that the Run item is available in the context 
menu. 

Report Viewer 

To verify that the Report Viewer is installed:  

1 In the Configuration Manager console, click Start > Control Panel > Programs and Features.  

2 Verify that Microsoft Report Viewer Redistributable is installed. 
 

Communication Ports and Protocols 

Communication ports used by Parallels Mac Management should not be used by other programs. 
Please review the following table and make sure that the ports listed are available. Please note that 
the table doesn't include ports used by the standard System Center Configuration Manager 
services and by standard Windows services. 

Program TCP UDP Platform Required Notes 

Configuration Manager 
Proxy 

pma_isv_proxy_service.exe 

8760, 
8761 

 Windows Required 

The default ports 8760 and 
8761 can be changed if 
needed using the 
Configuration Manager Proxy 
configuration utility. 

NetBoot Server 

pma_netboot_service.exe 

bootpd (DHCP) 

 67, 68 Windows Optional Required for the NetBoot 
Server functionality. 

NetBoot Server 

pma_netboot_service.exe 

tftpd (TFTP) 

 69 Windows Optional Required for the NetBoot 
Server functionality. 

NetBoot Server 

pma_netboot_service.exe 

HTTPD (Web) 

80  Windows Optional Required for the NetBoot 
Server functionality. 

SSH server 22  Mac Optional Required for the Network 
Discovery functionality. 
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VNC server 5900  Mac Optional Needed to accept VNC 
connections on a Mac. 

Mac client 8000  Mac Required 

Required for Parallels Mac 
Client to accept incoming 
connection from Parallels 
Configuration Manager Proxy. 

Additionally, you must enable RPC ports to allow WMI/RPC traffic to pass through. RPC ports can 
be opened by enabling the Group Policy firewall exception as described below: 

1 Edit the Group Policy object (GPO), which is used to manage Windows Firewall settings in your 
organization.  The GPO can be edited using the Group Policy Object Editor snap-in 
(gpedit.msc). 

2 In the GPO Editor, navigate to Computer Configuration / Administrative Templates / 
Network / Network Connections / Windows Firewall.  

3 Open either the Domain Profile or Standard Profile, depending on which profile you use.  

4 Right-click the Windows Firewall: Allow inbound remote administration exception item and 
choose Edit. 

5 Select the Enabled option and click OK. 
 

User Rights Requirements 
To install, configure, and run Parallels Mac Management for Microsoft SCCM, you will need to 
create and configure user accounts with sufficient privileges to perform their respective tasks. 
 

Permissions for Running Parallels Proxy Configuration Wizard 

A user that will be running the Parallels Configuration Manager Proxy Configuration Wizard must 
have specific permissions. This section describes these permissions. 

The material presented in this section considers two possible scenarios: 

• The Parallels Configuration Manager Proxy is configured for the first time. 

• The Proxy has been previously configured and you want to reconfigure it using a different user 
account. 

Some of the instructions apply to the first scenario only and some apply to both. Simply follow the 
instructions that correspond to your configuration and skip those that don't. 

Note: When creating (or choosing) a user account that you will use to configure Parallels Configuration 
Manager Proxy, consider the following. If Parallel Configuration Manager Proxy and Active Directory will 
run on different computers, the described permissions must be granted directly to the user or to a 
custom group (not a built-in group, like Administrators) to which the user belongs. If Parallels Proxy and 
AD will run on the same server, you can add the user to a built-in group. 
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Create a Domain User 

The user configuring Parallels Configuration Manager Proxy must be a domain user. You can 
choose an existing domain user or create a new one. 
 

Local Administrator Rights 

The user must have administrative rights on the computer where the Parallels Configuration 
Manager Proxy will be installed: 

1 Log into the computer that will run Parallels Proxy. 

2 Open Server Manager and navigate to Configuration / Local Users and Groups / Groups. 

3 Right-click the Administrators group and select Properties in the context menu. 

4 In the Select Users dialog, click Add and add the domain user you've created earlier. Click OK 
and then OK again. 

 
 

DCOM Remote Activation Permission 

The user must have the DCOM Remote Activation permission: 

1 On the computer where the SMS Provider is installed, click Start > Administrative Tools > 
Component Services. 

2 In the Component Services window, navigate to Console Root / Component Services / 
Computers / My Computer / DCOM Config. Scroll down to Windows Management and 
Instrumentation, right-click it, and then click Properties in the context menu. 

3 Click the Security tab. The Launch and Activation Permissions section will have either the 
Use Default or the Customize option selected depending on your server configuration.  

4 If the Customize option is selected, click the Edit button, then add the user to the list and 
grant the user the Remote Activation permission. You may skip the remaining steps. 

5 If the Use Default option is selected, close this window and continue with the following steps. 

6 In the Component Services window, navigate to Console Root / Component Services / 
Computers. Right-click My Computer and click Properties in the context menu. 

7 Click the COM Security tab. 

8 In the Launch and Activation Permissions section, click Edit Default. 

9 Add the user to the list and grant the user Remote Activation permission. 

 
 

Administrative Rights in SCCM 

The user must have full administrator rights in Configuration Manager: 
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1 Log into the computer running the Configuration Manager console. 

2 In the Configuration Manager console, navigate to Administration / Overview / Security. 

3 Right-click Administrative Users and click Add User or Group in the context menu. 

4 In the Add User or Group dialog, click Browse, find the domain user that you created earlier, 
and then click OK. The user will appear in the User or group name field in the Add User or 
Group dialog. 

5 Click the Add... button in the Assigned security roles section. 

6 In the Available security roles list, select Full Administrator and click OK. 

7 Click OK to close the Add User or Group dialog. 

 
 

Permissions in Active Directory 

The user must have the necessary permissions in Active Directory. These permissions are required 
to create Parallels Mac Management-specific containers in AD and to manipulate data in these 
containers. 

To grant the permissions: 

1 Open ADSI Edit by clicking Start > Administrative Tools > ADSI Edit. 

2 Verify that the following container exists: DC=<domain> / DC=<com> / CN=System / 
CN=ParallelsServices. 

3 If the container above doesn't exist, grant the user the Create All Child Objects and Read 
permissions on the CN=System container. When granting these permissions to the user, apply 
it to This object and all descendant objects. 

4 If the container exists, do the following: 

• Make sure the user have Read, Write, and Create All Child Objects permissions on it. 

• Make sure the user has the Full Control permission on the CN=ParallelsServices / 
PmaConfigMgrProxy-<site-code> container. 

5 Verify that the DC=<domain> / DC=<com> / CN= Program Data / CN=Parallels container 
exists. 

6 If the container above doesn't exist, grant the user the Create All Child Objects and Read 
permissions on the CN=Program Data container. When granting these permissions to the user, 
apply it to This object and all descendant objects. 

7 If the CN=Parallels container exists, continue with the following steps. 

8 Verify that the CN=Parallels / CN=Parallels Management Suite container exists. If it doesn't, 
grant the user the Create All Child Objects and Read permissions on CN=Parallels container. 

9 If the CN=Parallels / CN=Parallels Management Suite container exists, make sure that the user 
has Read, Write, and Create All Child Objects permissions on it. 
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Permissions to Read/Write Service Principle Name 

The user must have permissions to read/write Service Principle Name. These permissions are 
required for the RBAC functionality. The Parallels Configuration Manager Proxy service account 
must have a registered Service Principle Name (SPN) for Kerberos connections. By default (with 
some exceptions) users are not permitted to register SPN to their own accounts. 

To grant the permissions: 

1 Open ADSI Edit by clicking Start > Administrative Tools > ADSI Edit. 

2 Locate the required object: 

• If you specify a user as a service account during the configuration, you should locate this 
user object. 

Note: The user object you select in this step must be the object of the user that will be used to run the 
service, not of the user that will be used to configure it. If you'll be using the same user to configure and 
to run the Parallels Configuration Manager Proxy service, then select the domain user object that you 
created in previous steps. 

• If you choose LocalSystem as a service account during the configuration, you should locate 
the computer object you are running Proxy on. 

3 Right-click the object, select Properties in the context menu, and then click the Security tab in 
the user properties dialog. 

4 Add the user that will be configuring the Parallels Configuration Manager Proxy to the Group or 
user names list and then click the Advanced button. 

5 In the Advanced Security Settings dialog, select the user that you added to the list in the 
previous step and click the Edit button. 

6 In the Permission Entry dialog, click the Properties tab. 

7 In the Apply to drop-down list, select This object only. 

8 In the Permissions list, select the Read servicePrincipalName and Write 
servicePrincipalName permissions. 

9 Close all dialogs. 
 

Microsoft SQL Server Permissions 

The user must have necessary permissions in Microsoft SQL Server. These permissions are 
needed to create and use a database storing the Parallels Mac Management data. 

To grant the user the right to create databases in SQL Server, assign the user to the dbcreator role 
as follows: 

1 Run SQL Server Management Studio by clicking Start > All Programs > Microsoft SQL 
Server 2008 R2. 
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2 Connect to the SQL server. 

3 Verify that the user that will be configuring Parallels Configuration Manager Proxy exists in 
Security / Logins. If the user doesn't exist, add the user to the Logins list. To do so, right-click 
Logins and then click New Login. Select Windows authentication and specify the Login 
name as domain\username (or click Search to search for the user). Click OK when done. 

4 Navigate to Security / Server Roles, right-click the dbcreator role, and then click Properties 
in the context menu. 

5 In the Server Role Properties dialog, click Add... 

6 In the Select Logins dialog, click Browse to search for and select the user that will configure 
Parallels Configuration Manager Proxy. 

7 Close all dialogs. 

If you have previously configured Parallels Mac Management Proxy on this site, then the Parallels 
Mac Management database should already exist in this SQL Server instance. To verify this, connect 
to the SQL Server and look for a database named "PMM_<side-code>" (where <site-code> is your 
SCCM site code). If a database with such a name exists, then perform the steps below. If the 
database doesn't exist, skip to the next section. 

Assuming that the "PMM_<side-code>" database exists, grant the user the necessary permissions 
on it as follows: 

1 In Microsoft SQL Server Management Studio, navigate to Security / Logins. 

2 Right-click the user that will configure the Parallels Proxy and click Properties. 

3 In the left pane, click User Mapping. 

4 In the right pane, select the "PMM_<side-code>" database (select the Map checkbox) and then 
select the following roles in the Database role membership list: 

• db_datareader 

• db_datawriter 

• db_ddladmin 

• db_securityadmin 

• public 

5 Click OK. 

 
 

Administrative Rights in Authorization Manager 

If Parallels Configuration Manager Proxy has been configured previously and the Authorization 
Store exists, the user configuring the Parallels Proxy must be assigned to the Administrator role in 
Authorization Manager.  

To assign the user to the Administrator role: 
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1 Start Microsoft Management Console (run mmc.exe). 

2 In the MMC, click File > Add/Remove Snap-in... 

3 Select Authorization Manager in the Available snap-ins list and click Add. 

4 Click OK. 

5 Right-click Authorization Manager and then click Open Authorization Store... 

6 Select Active Directory or Active Directory Application Mode (ADAM) and click Browse. 

7 Select CN=Authorization Store,CN=Parallels Management Suite,CN=Parallels,CN=Program 
Data, DC=<domain>,DC=<com>. 

8 Click OK and OK again to close the dialogs. 

9 Expand Authorization Manager in the left pane, right-click Authorization Store, and then click 
Properties. 

10 Click the Security tab. 

11 In the Authorization Manager user role drop-down list, select Administrator. 

12 Click Add and add the user that will configure Parallels Proxy to the Users and groups that 
are assigned to this role list. 

13 Click OK to save the changes and close the dialog. 

 
 

Permissions for Running Parallels Proxy Service 

Parallels Configuration Manager Proxy runs as a service in Windows. The user account under which 
it runs must have specific permissions. This article describes these permissions. 

Note: When creating (or choosing) a user account that will be used to run the Proxy service, consider the 
following. If Parallel Configuration Manager Proxy and Active Directory will run on different computers, 
permissions must be granted directly to the user or to a custom group (not a built-in group, like 
Administrators) to which the user belongs. If the Proxy and AD will run on the same server, you can add 
the user to a built-in group. 

The user configuring Parallels Configuration Manager Proxy must be a domain user. You can use 
and existing domain user or you can create a new one. 

The user must be a local administrator on the computer running the Parallels Configuration 
Manager Proxy. 

The user must have the DCOM Remote Activation permission. To grant the permission: 

1 On the computer where the SMS Provider is installed, click Start > Administrative Tools > 
Component Services. 
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2 In the Component Services window, navigate to Console Root / Component Services / 
Computers / My Computer / DCOM Config. Scroll down to Windows Management and 
Instrumentation, right-click it, and then click Properties in the context menu. 

3 Click the Security tab. The Launch and Activation Permissions section will have either the 
Use Default or the Customize option selected depending on your server configuration. 

4 If the Customize option is selected, click the Edit button, then add the user to the list and 
grant the user the Remote Activation permission. 

5 If the Use Default option is selected, close this window and continue with the following steps. 

6 In the Component Services window, navigate to Console Root / Component Services / 
Computers. Right-click My Computer and click Properties in the context menu. 

7 Click the COM Security tab. 

8 In the Launch and Activation Permissions section, click Edit Default. 

9 Add the user to the list and grant the user Remote Activation permission. 

The user must have full administrator rights in Configuration Manager. To set the rights: 

1 Log into the computer running the Configuration Manager console. 

2 In the Configuration Manager console, navigate to Administration / Overview / Security. 

3 Right-click Administrative Users and click Add User or Group in the context menu. 

4 In the Add User or Group dialog, click Browse, find the domain user that you created earlier, 
and then click OK. The user will appear in the User or group name field in the Add User or 
Group dialog. 

5 Click the Add... button in the Assigned security roles section. 

6 In the Available security roles list, select Full Administrator and click OK. 

7 Click OK to close the Add User or Group dialog. 

8 If the CN=System / CN=ParallelsServices / CN=PmaConfigMgrProxy-<site-code> container 
exists in Active Directory, the user must have Read, Write, and Create All Child Objects 
permissions on it. 

 

Permissions for Running Parallels OS X Software Update Point 

A user account must be configured for running the Parallels OS X Software Update Point service. 
The account must meet the following requirements: 

• Have administrative rights on the local server. 

• Be a member of the WSUS Administrators group.  

For additional information, please see Parallels OS X Software Update Point Requirements (p. 
15). 

 
 



24 
 

Pre-Installation Procedures 
 

Configuring Configuration Manager Boundaries 
Before deploying Parallels Mac Client on Mac computers, you need to configure Configuration 
Manager Boundaries. Boundary is a network location on the intranet that can contain one or more 
Mac computers that you want to manage. Mac computers are assigned as clients to SCCM 
according to the boundaries configured in the Configuration Manager console.  

Note: Please make sure that you complete all of the steps described below or you will not be able to 
enroll your Mac computers in Configuration Manager. 

Create a Boundary 

To create new (or modify an existing) boundary: 

1 In the Configuration Manager console, navigate to Administration / Overview / Hierarchy 
Configuration / Boundaries. 

2 To create a new boundary, right-click Boundaries and click Create Boundary. To modify an 
existing boundary, right-click it and select Properties from the context menu. 

3 On the General tab page, select the desired boundary type and specify the value(s) in such a 
way that IP addresses of your Mac computers lie within this boundary. Please note that 
Parallels Mac Management supports the following boundary types: 

• IP subnet 

• IP address range 

• Active Directory site 

Create a Boundary Group 

After you create a boundary, you need to create a boundary group, add the boundary to it, and 
associate a site system server with the group. 

To create a new or modify an existing boundary group: 

1 In the Configuration Manager console, navigate to Administration / Overview / Hierarchy 
Configuration / Boundary Groups. 

2 To create a new boundary group, right-click Boundary Groups and click Create Boundary 
Group. To modify an existing boundary, right-click it and select Properties from the context 
menu. 

3 On the General tab page, specify a boundary name and optional description. 

4 Click the Add button and select a boundary from the list. Click OK. 

5 On the References tab page, select the Use this boundary group for site assignment 
option.  
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6 Select your site in the Assigned site drop-down box. 

7 In the Content location section, click the Add button and select a site system server to 
associate with this boundary group. Click OK. 

8 Click OK to save the boundary group and close the window. 
 

Configuring Windows Firewall 
To enable Parallels Configuration Manager Proxy and Parallels NetBoot Server network 
communications, their executable files must be added to the Windows firewall exception list.  

The name and path of the Configuration Manager Proxy executable is: 

%ProgramFiles(x86)%\Parallels\Parallels Mac Management for Microsoft 
SCCM\pma_isv_proxy_service.exe 

The name and path of the NetBoot Server executable is: 

%ProgramFiles(x86)%\Parallels\Parallels Mac Management for Microsoft 
SCCM\pma_netboot_service.exe 

To add the executables to the Windows firewall exception list, open the Windows Control Panel 
and click (or double-click) Windows Firewall. Add the .exe files to the list of programs allowed 
through Windows Firewall.  

For the list of ports used by Parallels Mac Management for Microsoft SCCM, see Services, Ports 
and Protocols (p. 16). 
 

Integrating Parallels Mac Management with PKI 
Parallels Mac Management for Microsoft SCCM can be directly integrated with Public Key 
Infrastructure (PKI). Such integration enables the use of certificates for advanced user 
authentication and secure access to SCCM. 

If you would like to integrate Parallels Mac Management with PKI, you need to complete the steps 
described in the following subsections prior to installing Parallels Mac Management. If not, you can 
skip this section and continue with Installing Parallels Mac Management for Microsoft SCCM 
(p. 30). You can perform the PKI integration at any time later by completing the steps described in 
this section and then reconfiguring Parallels Mac Management. The reconfiguration involves running 
the Configuration Manager Proxy Configuration Wizard (described later in this guide) and 
specifying the appropriate options on the Parallels Client certificate management settings page 
of the wizard. 
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PKI Integration Overview 

The integration of Parallels Mac Management for Microsoft SCCM with PKI enables the following 
security features: 

• Obtaining security certificates for assigned Mac computers from a certificate authority trusted 
by SCCM. 

• Securing communications between Mac computers and SCCM by using mutual authentication 
and encrypted data transfers. 

Parallels Mac Management supports certificate authority certificates on the following versions of 
Windows: 

• Windows Server 2008  

• Windows Server 2008 R2 

• Windows Server 2012 

• Windows Server 2012 R2 (or newer) 

Note: Integration is provided for Microsoft Certificate Services only. No third-party certificate services are 
supported 

 

What This Section Does Not Cover 

The material presented in this section does not cover any of the concepts behind PKI design and 
implementation. It describes what needs to be done in order to integrate Parallels Mac 
Management with an existing PKI installation. If you would like to learn more about PKI, you can 
read the Securing Public Key Infrastructure (PKI) content on the Microsoft's website, which can 
be found at the following URL: https://technet.microsoft.com/en-
us/library/dn786443.aspx 
 

Creating Certificate Templates for Parallels Proxy and Mac Computers 

To enable Mac connectivity to HTTPS-enabled SCCM infrastructure, a Mac must obtain digital 
certificates from the certificate authority (CA) trusted by SCCM. Digital certificates secure the 
communication between Mac computers and the Configuration Manager site by using mutual 
authentication and encrypted data transfers. 

Creating a Certificate Template for Parallels Configuration Manager Proxy 

To create a certificate template: 

1 In Windows, click Start > Administrative Tools > Certification Authority. 

2 Expand the tree of your Certification Authority.  
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3 Right-click Certificate Templates and click Manage. The Certificate Template Console 
opens. 

4 In the template list, locate Web Server, right-click it and then click Duplicate Template. The 
Properties of New Template dialog opens.  

5 On the Compatibility tab page, select Windows Server 2008 as Certification Authority and 
Windows 7 / Server 2008 R2 as Certificate recipient. 

6 On the General tab page, specify a template name. 

7 On the Cryptography tab page: 

• Set Minimum key size to 2048. 

• Set Provider Category to Legacy Cryptographic Service Provider. 

• Set Algorithm to Determined by CSP. 

8 On the Request Handling tab page, select the Allow private key to be exported option. 

9 On the Subject Name tab page, select the Supply in the request option and the Use subject 
information from existing certificates for autoenrollment renewal requests option. 

10 On the Extension tab page, double-click the Application Policies extension, then click Add 
and select Client Authentication from the list. Click OK and then OK again. The Client 
Authentication description should appear in the Description of Application Policies list. 

11 On the Security tab page, add the server that hosts Parallels Configuration Manager Proxy and 
the user account under which the Proxy is running. Grant them Enroll and Autoenroll 
permissions. Please note that if the Proxy is running under the LocalSystem account, then you 
only need to add the computer name. 

12 Click OK to close the Properties of New Template dialog. 

13 Close the Certificate Template Console. 

14 Back in the Certification Authority window, right-click Certificate Templates again and 
choose New > Certificate Template to Issue. 

15 Select the template that you created in the previous steps and click OK to enable it. 

Creating a Certificate Template for Mac Computers 

To create a certificate template: 

1 In Windows, click Start > Administrative Tools > Certification Authority. 

2 Expand the CA tree, right-click Certificate Templates and click Manage. 

3 The Certificate Template Console opens. 

4 In the template list, locate Workstation Authentication, right-click it and then click Duplicate 
Template in the context menu. 

5 On the Compatibility tab page, select Windows Server 2008 as Certification Authority and 
Windows 7 / Server 2008 R2 as Certificate recipient. 
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6 On the General page, specify a template name. 

7 On the Cryptography tab page: 

• Set Minimum key size to 2048. 

• Set Provider Category to Legacy Cryptographic Service Provider. 

• Set Algorithm to Determined by CSP. 

8 On the Request Handling tab page, select the Allow private key to be exported option. 

9 On the Subject Name tab page, select the Supply in the request option. The Certificate 
Templates message box will pop. Click OK to close it. 

10 On the Subject Name tab page, select Use subject information from existing certificates 
for autoenrollment renewal requests option. 

11 On the Extension tab page, make sure that Client Authentication is displayed in the 
Description of Application Policies list. If it's not, add it. 

12 On the Security tab page, add the server that hosts Parallels Configuration Manager Proxy and 
the user account under which the Proxy is running. Grant them Enroll and Autoenroll 
permissions. If the Proxy is running under the LocalSystem account, then you only need to add 
the computer name. 

13 Click OK to close the Properties of New Template dialog. 

14 Close the Certificate Templates Console. 

15 In the Certification Authority window, right-click Certificate Templates and click New > 
Certificate Templates to Issue. 

16 In the Enable Certificate Templates dialog, select the template that you created in the 
previous steps and click OK to enable it. 

 

Creating a Security Group 

Create a dedicated security group and grant it the rights to request certificates from the certificate 
authority. The following users must be added to this group:  

• An administrator who will be installing and configuring Parallels Configuration Manager Proxy. 
This is needed because the Parallels Proxy configuration utility will request the certificate for the 
Proxy. 

• An account under which the Parallels Configuration Manager Proxy service will run. This is 
needed because the Proxy will be requesting certificates for Mac computers. 

 

Handling Expired Certificates 

Parallels Proxy can automatically handle a situation when digital certificates issued to Mac 
computers or the Parallels Proxy itself expire. It can also detect if a signing certificate of the 
certification authority (CA) has changed, thus invalidating the currently issues certificates. The 
following describes how Parallels Proxy handles the above events: 
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• When Parallels Proxy needs to communicate with a Mac, it first examines the digital certificate 
of the Parallels Mac Client running on it. If a certificate has expired or will expire soon (you can 
configure how soon), it will automatically renew the certificate. 

• Parallels Proxy will also check if the signing certificate of the currently used certification authority 
matches the one on the Parallels Mac Client's certificate. If it's not, a new certificate will be 
issued for the Parallels Mac Client using the current CA. 

• Parallels Proxy validates its own digital certificate at preset intervals (the time interval can be 
configured). If a certificate is not valid, a log entry is created in the isv_proxy_service.log 
file and in the Windows event log. The relevant log entries can be viewed in the 
%WINDIR%\Logs\pma_isv_proxy_service.log file and in the Windows event viewer 
(eventvwr) by navigating to Windows Logs > Application and searching for "Parallels Mac 
Management for Microsoft SCCM" entires. 

Note: Parallels Mac Management v5.0 doesn't support automatic renewal of the Parallels Proxy 
certificate. This functionality may become available in a later version of Parallels Mac Management. For 
the instructions on how to renew the certificate manually, please read 
http://kb.parallels.com/en/123836. 

You can configure digital certificate validation parameters according to your needs by making 
changes in Windows registry at the following location: 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\services\pma_cm_proxy\Parameters 

Use the following key values to modify the configuration: 

PkiCertificateExpirationThresholdDays 
Type: DWORD 

Default: 30 

Description: Specifies how soon a Parallels Client certificate must be renewed. The value 
denotes the number of days until a certificate expiration date. For example, let's say the value of 
this parameter is set to 30 (which is default). During validation, if a given certificate will expire in 
30 days or earlier, it will be automatically renewed. If the certificate expires in 31 or more days, 
then it will be validated again the next time Parallels Proxy communicates with the Parallels Mac 
Client. 

CDWORDmProxyPkiCertificateCheckPeriodSecs 
Type: DWORD 

Default: 86400 (1*24*60*60 or once in 24 hours) 

Description: Specifies the time interval, in seconds, at which Parallels Proxy validates its own 
certificate. The minimum allowed value is 30 seconds. 

ForcePkiCertificateValidation 
Type: DWORD 

Default: 0 
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Description: This parameter turns logging on or off for certificates that are not compliant with 
base policy. If the parameter is set to zero (default), no log entries will be created for such 
certificates. Any non-zero value enables logging. Please note that this parameter is not related 
to certificate expiration dates. It creates log entires if a chain of trust cannot be established with 
a given certificate. 

 

This chapter will take you through the installation of Parallels Mac Management for Microsoft 
SCCM. 
 

Installation Overview 
Parallels Mac Management for Microsoft SCCM consists of several components, which are 
installed in Windows using the same installation wizard (except Parallels Mac Client, which is 
installed in OS X). If you are installing the components on different servers, run it on each server and 
select only the component(s) that you want installed on that particular server. 

Please note that Parallels Configuration Manager Proxy must be installed on each primary SCCM 
site. If you have secondary sites, you can choose from the following installation options: 

• Installing Parallels Configuration Manager Proxy on the primary and secondary sites. This option 
allows you to better manage bandwidth utilization between Mac computers, the distribution 
point, and the management point. You must install Parallels Configuration Manager Proxy on 
the primary site and then on a secondary sites (in that order). 

• Installing Parallels Configuration Manager Proxy on the primary site only. If you use this option, 
Mac computers will communicate directly with the Configuration Manager Proxy installed on the 
primary site. 

Before running the installation wizard, please make sure that you have read Installation 
Requirements (p. 12) for each component that you are planning to install. 
 

Running the Setup Wizard 
The Parallels Mac Management for Microsoft SCCM Setup wizard is used to install Parallels 
Mac Management. When you run the wizard, you need to select the components you wish to install 
on a given server. The rest of the installation is mostly automatic. 

Installation and Configuration 
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Maintenance and Upgrade 

Viewing Proxy Service Certificate Details 

The account that you use to run the Parallels Configuration Manager Proxy service must have 
permissions to access the certificate store on the local computer and to read the Configuration 
Manager Proxy certificate private key. The permissions are set automatically when you run the 
Configuration Manager Proxy Configuration Wizard and specify the account for running the 
service.  

If you experience difficulties accessing Mac computers from the Configuration Manager console, 
verify that certificate permissions are valid for the account that you use to run the Parallels 
Configuration Manager Proxy service. 

To view the certificate store permissions 

1 Run regedit.exe on the computer where the Configuration Manager Proxy is installed. 

2 Navigate to HKLM\Software\Microsoft\SystemCertificates. 

3 Right-click SystemCertificates and select Permissions from the context menu. 

4 In the Permissions for SystemCertificates dialog, verify that the user that you use to run the 
Configuration Manager Proxy service has the Read permission selected. 

To verify that the Configuration Manager Proxy service account has permissions to 
read the certificate private key 

1 Open the Microsoft Management Console (MMC) from the Start menu by clicking Run and 
then typing "mmc". 

2 In the File menu, select Add/Remove Snap-in... 

3 In the Add or Remove Snap-ins dialog, find and select Certificates in the Available snap-ins 
list. Click Add. 

4 In the Certificate snap-in dialog, select Computer account and then select Local computer. 

5 Click OK in the Add or Remove Snap-in dialog. 

6 In the snap-in tree, navigate to Certificates (Local Computer)\Personal\Certificates and 
expand it to view the available certificates. 

7 Make sure that the Configuration Manager Proxy certificate exists. If it doesn't, run the 
Configuration Manager Proxy configuration utility. 

8 Right-click the Configuration Manager Proxy certificate, point to All Tasks, and then click 
Manage Private Keys. 

9 In the Permissions for Configuration Manager Proxy private keys dialog, verify that the user 
(or a group to which the user belongs) has Read access to the certificate's private key. 
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Migrating Configuration Manager Proxy 

This section describes how to migrate the Parallels Configuration Manager Proxy to another server 
on the same Configuration Manager site. 

To migrate the Parallels Configuration Manager Proxy: 

1 Export the Proxy certificate from the Windows Certificate Store on the current server. 

2 Uninstall the Proxy from the current server. 

3 Import the certificate into the Windows Certificate Store on the new server. 

4 Install the Proxy on the new server. 

The following describes the certificate export and import procedures. The Proxy installation and 
uninstallation procedures are described in Install Parallels Mac Management for Microsoft 
SCCM (p. 30). 

Exporting Certificate from Certificate Store 

To export a certificate: 

1 Open the Microsoft Management Console (mmc.exe). 

2 In the console, click File > Add/Remove Snap-in to open the Add or Remove Snap-ins 
dialog. 

3 Click Certificates in the Available snap-ins list. 

4 Click the Add button. Select the Computer account option and click Next. 

5 On the Select Computer page, select Local computer and click Finish. Click OK to close the 
Add or Remove Snap-ins dialog. 

6 In the Microsoft Management console, click Console Root / Certificates(Local computer) / 
Personal / Certificates. 

7 Right-click the Parallels Configuration Manager Proxy certificate and then click the All Tasks > 
Export... option in the context menu. The Certificate Export Wizard opens. 

8 Click Next on the Welcome page. 

9 Select Yes, export the private key and click Next. 

10 On the Export File Format page, select the following options: 

• Personal Information Exchange - PKCS #12 (.PFX) 

• Include all certificates in the certification path if possible 

• Export all extended properties 

11 Click Next. 
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12 On the Password page, type and confirm a password (you’ll be asked for it when importing the 
certificate on the new server). Click Next. 

13 Type a path and filename for the target certificate file (e.g. C:\sccm_proxy.pfx) and click 
Next. 

14 Review the export summary and click Finish to complete the wizard. 

15 Copy the certificate file to the server where you want to migrate the Configuration Manager 
Proxy. 

Importing Certificate into Certificate Store 

To import a certificate: 

1 Open the Microsoft Management Console (mmc.exe). 

2 In the console, click File > Add/Remove Snap-in to open the Add or Remove Snap-ins 
dialog. 

3 Click Certificates in the Available snap-ins list. 

4 Click the Add button. Select the Computer account option and click Next. 

5 On the Select Computer page, select Local computer and click Finish. 

6 Click OK to close the Add or Remove Snap-ins dialog. 

7 In the Microsoft Management console, click Console Root / Certificates(Local computer). 

8 Right-click the Personal node and then click the All Tasks > Import... item in the context 
menu. The Certificate Import Wizard opens. 

9 Click Next. 

10 On the File to Import page, click the Browse button and select the “.pfx” certificate file that 
you exported earlier (make sure to change the filter in the Open dialog to .pfx). Click Next. 

11 On the Password page, type the password that you entered when you exported the certificate 
and select the Mark this key as exportable... option. 

12 Click Next. 

13 On the Certificate Store page, select the Place all certificates in the following store option. 
Make sure that the Certificate store field is set to Personal (if it doesn't, click the Browse 
button and select Personal from the list). 

14 Click Next. 

15 Review the import summary and click Finish to complete the wizard. 

16 Install and configure Configuration Manager Proxy on the new server by running the Parallels 
Mac Management for Microsoft SCCM installer. 

17 Mac computers will automatically discover the new Parallels Configuration Manager Proxy and 
will update their own local Proxy connection records. For more information, please see 
Updating Proxy Connection URL (p. 69). 
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Upgrading Parallels Mac Management 

To upgrade Parallels Mac Management to a newer version, you need to uninstall the current 
version and then install a new one.  

To run the uninstaller, go to Control Panel > Programs > Uninstall a program and uninstall the 
Parallels Mac Management for Microsoft SCCM program. If Parallels Mac Management 
components are installed on different servers, you need to uninstall each component individually. 
When done, install the new version of Parallels Mac Management for Microsoft SCCM. Please note 
that after upgrading Parallels Mac Management, you need to upgrade the Parallels Mac Client on 
each managed Mac. See Upgrading Parallels Mac Client (p. 70) for more information. 

 



 

 

This chapter explains how the Parallels Mac Management licensing works and how to obtain a 
license and use it to activate a Parallels Mac Management installation.  

You can read more about Parallels Mac Management licensing in the Parallels Mac Management 
for Microsoft SCCM Licensing Guide, which is available for reading and download on the 
Parallels website. 

In This Chapter 

Parallels Mac Management Licensing ....................................................................... 45 
Activate Parallels Mac Management ......................................................................... 52 
 
 

Parallels Mac Management Licensing 
Parallels Mac Management for Microsoft SCCM is licensed on a per managed Mac basis. The 
number of individual licenses in your subscription denotes the number of Mac computers that you 
can manage in SCCM. 

You license Parallels Mac Management with a prepaid subscription, which works as follows: 

• A subscription is purchased for a predefined period of time. 

• A subscription can include any number of individual licenses (the maximum number of Mac 
computers that you can manage). 

• Support is included in the cost of the subscription. 

No matter how many licenses in your subscription, you'll receive a single license key. A license key 
can be used to activate a single installation of Parallels Mac Management. If you need to activate 
several Parallels Mac Management installations to work simultaneously, you need multiple license 
keys. 

 
 

Purchasing a Subscription 

To purchase a Parallels Mac Management subscription, please contact the Parallels Sales team or 
a Parallels Partner/Reseller. 
 

C H A P T E R  3  

Licensing and Activation 
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Obtaining a Trial License 

If you would like to evaluate Parallels Mac Management, you need to obtain a trial license from the 
Parallels Sales team or a Parallels Partner/Reseller. 
 

Create a Parallels My Account 

Parallels My Account is a web application that enables Parallels customers (consumers and 
organizations) to view and manage licenses for various Parallels products. The instructions below 
describe how to quickly get started with Parallels My Account. 

You can create an account for your company or organization when you first create a Parallels My 
Account, or after you already created a private account. 

Create a Parallels My Account from scratch 

If you are a new customer and don't have a Parallels My Account, you can create one for yourself 
and for your organization as follows: 

1 Visit Parallels My Account at https://account.parallels.com 
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2 Click Register. The registration page opens. 

 

3 Select the I represent a company or an organization option. This step is required to create a 
business account for your organization. 

4 Specify your personal and your company info (all fields are required) and click Create Account.  

This creates an account for you personally and a business account for your organization to which 
you are assigned as the account administrator. When you log in to your account using you email 
address and password, you can manage personal and business products from the same account. 

Creating a Parallels business account from an existing account 

If you already have a personal Parallels My Account, follow these steps to create a business 
account for your organization: 
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1 Log in to Parallels My Account using your email address and password. 

2 Click  next to your user name to open a side menu. If the Dashboard page is not already 
displayed, click Dashboard in the side menu. 

3 On the Dashboard page, click Create a business account in the Quick Actions section. 

 

4 A message box opens with an explanation of what a business account is. Read it and then click 
Proceed. 

5 In the Registering a Business Account dialog, type the name of your organization and then 
specify your country, state/city (if applicable), ZIP or postal code, and your business phone 
number. 

 

6 When done, click Create a Business Account. 
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A business account is created for your organization to which you are assigned as the account 
administrator. When you log in to your personal account, you can manage personal and business 
products from the same account. 
 

Register a Subscription 

To register your subscription in Parallels My Account: 

1 Sign in to Parallels My Account using your email address and password. 

2 Click  next to your user name to open a side menu. If the Dashboard page is not already 
displayed, click Dashboard in the side menu. 

 

3 Click the Register a license key link in the Quick Actions section. The Register a License 
Key page opens.  

You can also open this page by expanding Subscriptions and Licenses section in the side 
menu, then clicking Corporate Subscriptions, and finally clicking the Register a License Key 
link. 

 

4 Type the license key that you received with your subscription and click Register. 

5 When your license key is registered, you will see a confirmation message. 
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6 If you would like to view your subscription information, click the Open Corporate 
Subscriptions button. This will open the Subscription Details page where you can view the 
information. 

Your subscription is now registered and your license key can be used to activate the Parallels 
product to which it applies. 
 

Creating Sublicenses 

A sublicense is a virtual license that is linked to the master license but has its own license key, the 
total number of individual licenses you allocate to it, and its own expiration date.  

Planning for sublicenses 

Sublicenses are useful in these typical scenarios: 

• You want to grant a division of your organization the ability to use a limited number of your 
available licenses. You can create a sublicense with a required number of licenses and give the 
sublicense key to the administrator for that division. 

• You have multiple SCCM sites and you want to activate them using different license keys with 
different number of total licenses allocated to each key. 

When allocating a maximum number of individual licenses to a sublicense, you need to decide 
whether they should be reserved for the sublicense or allocated dynamically: 

• If licenses are reserved, the master license key (or other sublicense keys) will have no access to 
these licenses.  

• If licenses are allocated dynamically, the sublicense will have to compete for them with the 
master license key and other dynamic sublicenses (if any). 

Creating a sublicense 

To create a sublicense: 

1 In the side menu, expand Subscriptions and Licenses and click Corporate Subscriptions.  

2 If you have more than one Parallels product registered, select Parallels Mac Management in the 
drop-down list and then click a subscription for which you want to create a sublicense. 

3 On the Subscription Details page, click Details in the Products section. 

4 On the Product Details page, click Create a Sublicense. 
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5 The New Sublicense dialog opens.  

 

6 Type a sublicense name. 

7 Specify the number of licenses to allocate to this sublicense. You can use any number up to the 
number displayed in the available for allocation field. 

8 In the Allocation type section, select one of the following options: 

• Allow to compete for the licenses on the go. The sublicense will have to compete for 
individual licenses with the master license key and other dynamic sublicenses. 

• Reserve the licenses. Licenses will be reserved for this sublicense and will not be available 
to the master license key or other sublicenses. 

9 In the Expires section, select one of the following: 

• With the subscription. The sublicense will have the same expiration date as the 
subscription. 

• On date. Specify a desired date if you want the sublicense to expire sooner that the 
subscription. 

10 Click Create to create a sublicense. 

11 The New Sublicense dialog opens where you can review the created sublicense. Note the 
License Key property. This is the key that was assigned to this sublicense. You'll need it to 
activate a Parallels Mac Management installation. You can copy or write it down now or you can 
do this later. 

12 Click Close to close the New Sublicense dialog. 

13 The sublicense appears on the Product Details page in the Sublicenses section.  

Modifying a sublicense 

To modify a sublicense, click the Edit link on the same row. This opens the Edit Sublicense dialog. 
You can modify any of the sublicense properties except the license key.  
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Please note that if you want to decrease the number of licenses in a sublicense, you have to make 
sure that no active Mac computers will be affected in the corresponding SCCM site. If the number 
of individual licenses in a sublicense falls below the number of active Mac computers, you will lose 
the ability to manage some of them. 

Deleting a sublicense 

To delete a sublicense, click the Edit link and then click the Delete button. You should only delete 
a sublicense if you never used it to activate Parallels Mac Management or if you deactivated the 
corresponding Parallels Mac Management installation prior to deleting the sublicense. 
 

Activate Parallels Mac Management 
After you registered your subscription in Parallels My Account, you can activate Parallels Mac 
Management using your license key. 

You can use the online or the offline method to activate Parallels Mac Management. The method 
you choose depends on the following: 

• If the server on which you have Parallels Proxy installed has limited or no Internet access, you 
must use the offline activation method. 

• If the server has Internet access, you can use the online activation method. 

The subsequent sections describe each method in detail. 
 

Activate Online 

To activate Parallels Mac Management using the online activation method: 

1 Open the Configuration Manager console. 

2 Navigate to Administration / Overview / Parallels Mac Management / Licenses. 

3 Right-click your site in the Licenses list and choose Activate license. 

4 The Parallels Mac Management - Activate License dialog opens. 

5 Input your license key and select the Activate online option. 

6 Click Next. 

7 Parallels Mac Management connects to the Parallels Licensing Server and verifies the key.  

8 If the key is valid, the license information is displayed on the screen. Review the information and 
click Activate. 

9 On successful activation, the display value of the License status column in the Licenses list in 
the SCCM console changes to Activated. 
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Your Parallels Mac Management installation is activated and the activation information is added to 
Parallels My Account. 
 

Activate Offline 

If the server on which you have Parallels Proxy installed has limited or no Internet access, you can 
use the offline activation method described below. 

To activate Parallels Mac Management:  

1 Open the Configuration Manager console. 

2 Navigate to Administration / Overview / Parallels Mac Management / Licenses. 

3 Right-click your site in the Licenses list and choose Activate license. 

4 The Parallels Mac Management - Activate License dialog opens. 

5 Input your license key and select the Activate offline option. 

6 Click Next. 

7 Click the Save button to save to offline activation request file. Specify a location and file name 
and click Save. Do not close the Parallels Mac Management - Activate License dialog. 

8 You now need to obtain the license activation file from Parallels My Account. To do so, visit 
https://account.parallels.com and sign in using your email address and password. 

9 Once signed in, click  next to your user name to open a side menu.  

10 In the side menu, expand the Parallels Mac Management section and click Offline Activation 
and Validation. 

11 On the Offline Activation and Validation page, specify the offline activation request file you 
saved earlier.  

12 Follow the instructions and download the license activation file. 

13 Go back to the Configuration Manager console. In the Parallels Mac Management - Activate 
License dialog, click Browse and select the license activation file you've obtained from 
Parallels My Account.  

14 Click Next. Your license information is displayed on the screen. Review the information and 
click Activate. 

15 On successful activation, the display value of the License status column in the Licenses list in 
the SCCM console changes to Activated. 

Your Parallels Mac Management installation is activated and the activation information is added to 
your Parallels My Account. 
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View and Update the License Information 

After you activate a Parallels Mac Management installation, you can view the license information in 
the Configuration Manager console. 

To view the license information: 

1 In the Configuration Manager console, navigate to Administration / Overview / Parallels Mac 
Management / Licenses. 

2 Right-click your site in the Licenses list and choose Properties. 

3 The Parallels Mac Management - License Information dialog opens where you can view the 
following information: 

• License key: The license key that was used to activate this installation. 

• Start date: The license key start date. 

• End date: The license key end date. 

• Number of licenses: The maximum number of Mac computers that can be managed in this 
installation. 

• Used licenses: The current number of managed Mac computers. 

• Remaining licenses: The number of licenses remaining. 

The license usage information is reported back to the Parallels Licensing Server automatically once 
a week. The information can then be viewed in Parallels My Account. This allows you to see the 
license usage info for all your Parallels Mac Management installations (if you have more than one) in 
one place.  

Note: If you activated Parallels Mac Management using the offline activation method, you need to 
synchronize the local license information with Parallels My Account using the offline refresh method as 
described in the following subsection. 

Refresh the license information 

The Refresh button on the  Parallels Mac Management - License Information dialog allows you 
to retrieve the current license information from the Parallels Licensing Server to reflect possible 
changes to your subscription. Normally, this update is done automatically every 24 hours if the 
server on which the Parallels Proxy is running has Internet access. By clicking the Refresh button, 
you can retrieve this information at any time.  This functionality is useful when, for example, you 
upgrade your subscription to have more licenses and want the licenses to become available in your 
Parallels Mac Management installation without waiting for the automatic refresh to happen. 

If the server on which Parallels Proxy is running has Internet access, simply click the Refresh 
button to update the license information. If the server has limited or no Internet access, read the 
following subsection. 



55 
 

Licensing and Activation 
 

Using the offline refresh method 

If the server hosting Parallels Proxy has limited or no Internet access, you must use the offline 
refresh method by following these steps: 

1 Click Refresh.  

2 If this Parallels Mac Management installation was activated using the offline method, you will 
first be asked to save the offline request file. 

3 After you save the file, you'll be asked to specify the file containing the latest subscription 
information. You must obtain this file from Parallels My Account. Don't close this dialog (you will 
return to it later). 

4 Visit https://account.parallels.com and sign in using your email address and 
password. 

5 Once signed in, click  next to your user name to open a side menu.  

6 In the side menu, expand the Parallels Mac Management section and click Offline Activation 
and Validation. 

7 On the Offline Activation and Validation page, specify the offline request file you saved earlier. 

8 Follow the instructions and download the subscription information file. 

9 Go back to the Configuration Manager console and select this file. 

10 Your local subscription information is updated with the latest information from the file you've 
obtained from Parallels My Account. 

 

Exceeding the License Limit 

Each Parallels Configuration Manager Proxy installed in an SCCM hierarchy constantly monitors the 
total number of Mac computers managed through it. If at any time the number of computers 
exceeds the license limit, the following happens: 

1 The information about the event is recorded to the Parallels Proxy log file. 

2 If an attempt is made to manually enroll a Mac in SCCM, an error message will be shown on 
the Mac during the registration procedure. 

3 All managed Mac computers will continue to be enrolled in SCCM and will retrieve their 
baselines normally. 

4 The Problem Monitor icon will indicate an error (will change its color to yellow) and will display a 
corresponding error message. The notification message (a balloon) will pop up in the Problem 
Monitor once an hour. 

5 Similar notification messages will be shown in the Configuration Manager console when you try 
to perform some of the administrative task, including: 

• Creating/editing Parallels Desktop and Virtual Machine configuration items. 

• Creating/editing Configuration Profiles. 
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• Creating/editing FileVault2 configuration items. 

• Pushing policies. 

What you can do when the license limit is exceeded 

If the license limit is exceeded, you can do the following: 

• To stop receiving alerts in the Configuration Manager console or the Problem Monitor, remove 
the excess Mac computers from SCCM. 

• If the Parallels Mac Management installation was activated using a sublicense, you can add 
more licenses to it in Parallels My Account. To do this, you must have unused licenses in the 
subscription. 

• If you used the master license key to activate Parallels Mac Management, then it means that 
you don't have any licenses left and need to upgrade your subscription (i.e. buy more licenses). 

 

Deactivating Parallels Mac Management 

You can deactivate a Parallels Mac Management installation and release the license key, so it can 
be used to activate Parallels Mac Management installed in another SCCM site. 

Depending on whether you activated Parallels Mac Management using the online or the offline 
activation method, the deactivation will be performed using the same method. 

To deactivate Parallels Mac Management: 

6 In the Configuration Manager console, navigate to Administration / Overview / Parallels Mac 
Management / Licenses. 

7 Right-click your site in the Licenses list and choose Properties. 

8 The Parallels Mac Management - License Information dialog opens. 

9 Click Deactivate. Depending on the original activation method, one of the following will 
happen: 

• Online activation: Parallels Mac Management connects to the Parallels Licensing Server and 
deactivates your Parallels Mac Management installation. You license key is released and you 
can use it to activate a different installation. If this is your case, you may stop reading here 
and skip the rest of this section. 

• Offline activation: Parallels Mac Management is deactivated, but the license key is not fully 
released. In order to complete the deactivation, you need to update the license key 
information on Parallels My Account. Follow the steps below to learn how to do it. 

10 You are asked to save the offline deactivation request file. Specify a location and file name and 
click Save. 

11 You now need to update your license information on Parallels My Account, so the license that 
you just released can be used to activate a different Parallels Mac Management installation. 
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12 Visit https://account.parallels.com and sign in using your email address and 
password. 

13 Once signed in, click  next to your user name to open a side menu.  

14 In the side menu, expand the Parallels Mac Management section and click Offline Activation 
and Validation. 

15 On the Offline Activation and Validation page, specify the offline deactivation request file you 
saved earlier. 

Parallels Mac Management is now deactivated and the license key can be used to activate a 
different installation. 

 



 

 

Parallels Mac Client is a software for Mac that enables communication between a Mac computer 
and the Parallels Configuration Manager Proxy. Before you can manage a Mac computer in SCCM, 
you need to install Parallels Mac Client on it and enroll the Mac in Configuration Manager. 

In This Chapter 

Installation Options Overview.................................................................................... 58 
Installing Parallels Mac Client Using Discovery Methods ........................................... 59 
Running Parallels Mac Client Installer on a Mac ........................................................ 65 
Installing Parallels Mac Client Using a Script ............................................................. 66 
Push Install or Update Parallels Mac Client ............................................................... 67 
Configuring the Firewall ............................................................................................ 68 
Verifying Parallels Mac Client Deployment................................................................. 69 
Updating Parallels Proxy Connection URL ................................................................ 69 
Uninstalling Parallels Mac Client................................................................................ 70 
Upgrading Parallels Mac Client ................................................................................. 70 
Using Parallels Mac Client Tools ............................................................................... 72 
 
 

Installation Options Overview 
Parallels Mac Client can be installed on Mac computers using one of the following methods: 

• Parallels Network Discovery (p. 59). Discovers Mac computers on the network, push installs 
Parallels Mac Client on them, and then enrolls each Mac in Configuration Manager. 

• SCCM Active Directory System Discovery (p. 59). Discovers domain joined Mac computers 
and adds them as resources to Configuration Manager. The Parallels Configuration Manager 
Proxy then identifies the discovered resources as Mac computers, push installs Parallels Mac 
Client on them, and enrolls Mac computers in Configuration Manager. 

• Running Parallels Mac Client installer on a Mac (p. 65). Log into a Mac and manually install 
Parallels Mac Client on it by running the installation package. 

• Using an installation script (p. 66). Use a script to install Parallels Mac Client on a Mac. The 
script can be executed manually on each Mac or it can be distributed to and executed on Mac 
computers using Apple Remote Desktop or a similar remote management software. 

• Push install or update Parallels Mac Client (p. 67). If a Mac computer is already enrolled in 
SCCM or has been added to it as an unmanaged resource, you can push install or update 
Parallels Mac Client on it right from the Configuration Manager console. 

 

C H A P T E R  4  

Parallels Mac Client Deployment 
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Installing Parallels Mac Client Using Discovery 
Methods 
Parallels Mac Management allows you to discover your Mac computers and push install Parallels 
Mac Client on them. The following discovery methods are supported:  

• Parallels Network Discovery 

• SCCM Active Directory System Discovery 

Parallels Network Discovery can discover any Mac on your network. Active Directory System 
Discovery can discover domain joined Mac computers. You can use one of the methods or both 
depending on your situation. For example, if all your Mac computers are domain joined, you can 
use SCCM AD System Discovery. If some (or all) of your Mac computers are non-domain joined, 
you can use Parallels Network Discovery to discover these Mac computers. 
 

Enabling Remote Access on Mac Computers 

To push install Parallels Mac Client on a discovered Mac, Parallels Proxy needs to log into it. In 
order to do this, the Mac must be configured to accept SSH connections and have an 
administrator account set up that the Parallels Proxy can use. This can be a domain account (for 
domain joined Mac computers) or a local account (for either domain joined or non-domain joined 
Mac computers). 

Grant Administrative Privileges on a Mac to a Domain User or Group 

If you want to use a domain account to push install Parallels Mac Client, you need to grant 
administrative privileges to it on a Mac. You can do this as follows: 

1 Open System Preferences > Users & Groups and click Login Options at the bottom of the 
left pane. 

2 In the right pane, click Network Account Server: Edit...  

Please note that if the button says "Join..." (not "Edit") then this Mac is not a member of a 
domain, so the following instructions will not work. 

3 In the dialog that opens, click Open Directory Utility. 

4 On the Services tab page of the Directory Utility dialog, select Active Directory and then 
click the pencil icon to edit the settings. 

5 In the dialog that opens, click Show Advanced Options and then click the Administrative tab. 

6 Select the Allow administration by option and add the desired domain user or group to the 
list. Remember the account as you will use it later to configure the client push installation.  

7 Click OK to save the changes and then close all dialogs. 
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Grant Administrative Privileges to a Local Mac User 

If you have Mac computers that are not members of a domain (or if you don't want to use a domain 
account for any reason), you need to create a local OS X user with administrative privileges. To add 
a user, open System Preferences > Users and Groups, click the plus-sign icon, select 
Administrator and specify the user information. Remember the user name and password as you 
will use it later to configure the client push installation. 

Enable SSH Access on a Mac 

Parallels Configuration Manager Proxy will connect to Mac computers over SSH, so you need to 
enable SSH access on each Mac. To do so: 

1 On a Mac, open System Preferences > Sharing. 

2 Enable the Remote login service. 

3 If you have granted permissions on this Mac to a domain account, add it to the list of users who 
are allowed remote access. If you'll be using a local user, add that user to the list. 

After enabling SSH access on a Mac and granting a local or a domain user SSH access, you 
should verify that you can actually establish an SSH connection. The Mac should allow SSH 
connection with password authentication. 

Using Multiple Accounts 

When creating local accounts or granting permissions to domain accounts on multiple Mac 
computers, you can set up the same account on all of them. This way you can configure Parallels 
Proxy to use the same account name and password to log into every Mac. However, if you want to 
use multiple accounts, you can do that too. For example, you can use one account on a certain 
group of Mac computers and another on a different group. Parallels Proxy will try every account 
that you configured, one by one, until a connection with a Mac can be established. Adding the 
account information to the push installation configuration is described later in this section.  
 

Configuring Parallels Mac Client Push Installation Properties 

Parallels Mac Client push installation properties must be configured, so that Parallels Proxy can 
push install Parallels Mac Client on discovered Mac computers. 

To configure push installation properties: 

1 In the Configuration Manager console, navigate to Administration / Site Configuration / Sites 
and select your SCCM site.  
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2 Click the Mac Client Push Installation toolbar item (or right-click on the site and choose 
Parallels Mac Client Push Installation). This opens the Parallels Mac Client Push 
Installation Properties dialog. 

 

3 On the General tab page, select the Enable automatic site-wide client push installation 
option. 

4 Specify one or more collections containing Mac computers to which you'll be push installing 
Parallels Mac Client. The Install client to all Mac OS X Systems option covers all Mac 
resources in every collection. The second option allows you to select one or more specific 
collections. 

5 Select the Accounts tab and then click the New icon to specify an account that will be used to 
push install Parallels Mac Client on discovered Mac computers. This can be a domain account 
or a local Mac account. See Enabling Remote Access on Mac Computers (p. 59) for the 
information on how to configure the accounts. 

6 Click OK to save the Parallels Mac Client push installation properties. 

Once the push installation properties are configured, Parallels Proxy will begin monitoring the 
system for discovered Mac computers. If you already have Mac resources in SCCM that don't have 
Parallels Mac Client installed, Parallels Proxy will identify these resources as Mac computers and 
will try to push install Parallels Mac Client on them. Newly discovered Mac computers will also be 
identified and the client will be push installed on them as well. The following sections describe how 
to configure and run Parallels Network Discovery and provides additional information about SCCM 
Active Directory System Discovery. 
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Using Parallels Network Discovery 

Parallels Network Discovery can discover Mac computers on your network and automatically push 
install Parallels Mac Client on them. Both domain joined and non-domain joined Mac computers 
can be discovered in one run. 
 

Configuring Parallels Network Discovery 

Before using Parallels Network Discovery to discover Mac computers and push install Parallels Mac 
Client on them, you need to configure it as described below: 

1 In the Configuration Manager console, navigate to Administration / Overview / Parallels Mac 
Management / Discovery Methods. The list in the right pane will be populated with one or 
more "Parallels Network Discovery" items according to the following conditions: 

• If you don't have secondary sites, the list will contain just one Parallels Network Discovery 
item. 

• If you have secondary sites, but Parallels Configuration Manager Proxy is installed only on 
the primary site, the list will contain just one item. 

• If you have secondary sites, and the Configuration Manager Proxy is installed on the primary 
and a secondary site, the list will contain one item for each site where the Proxy is installed. 

2 Right-click the Parallels Network Discovery item for the desired site and then select Properties. 
The Parallels Network Discovery properties dialog opens. 

General 

On the General tab page: 

1 Select the Enable network discovery option. 

2 Specify the TCP ports to scan (or use the default ports). Multiple ports can be separated by a 
comma, space, or semicolon. 

3 Select the Nmap timing policy from the drop-down list. The default Nmap settings provide the 
optimal balance between the quality of the results and the time it takes to scan the network. 

Accounts 

On the Accounts tab page, click the provided link to open the Parallels Mac Client Push 
Installation Properties dialog. If you haven't configured these properties yet, please refer to 
Configuration Parallels Mac Client Push Installation Properties (p. 60) for more information. 
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Boundaries 

On the Boundaries tab page, specify the Configuration Manager boundaries to search. You can 
use boundaries as a search option together with the options on the Subnets tab page. Searching 
boundaries should be the primary method. If you haven't configured boundaries and boundary 
groups in SCCM, you need to do it as described in the Configuring Configuration Manager 
Boundaries section (p. 24). 

Other elements on the Boundaries tab page are the following: 

• Boundary Groups — Lists boundary groups. Highlight a group to view its member boundaries 
in the list below it. To include the entire group in a discovery search, select the checkbox in 
front of the group name.  

• Boundaries — Lists boundaries that belong to the highlighted boundary group. Select the 
boundaries to include in a discovery search. 

• Filter — Allows you to specify a filter for the Boundaries to search lists. You can type any part 
of the text that might appear in the boundary's name, type, or description. 

Subnets 

On the Subnets tab page, you can specify the subnets to search:  

1 Select Search local subnets if that's what you want to do. To search other subnets (in 
addition to or instead of local subnets), click the New icon and then enter the Subnet and 
Mask information. Make sure that the Enable subnet search checkbox is selected and then 
click OK. 

2 On the Schedule tab page, click the New icon to set a schedule for running discovery. The 
Custom Schedule dialog opens. 

3 Set the start date and time for a discovery run. 

4 Set the discovery duration. This setting specifies the maximum length of time for a discovery 
run. If all resources are discovered before this time is up, the run will continue with minimal 
network traffic. If the run doesn't complete before this time, only the resources already 
discovered will be included in the result. 

5 In the Recurrence pattern group box, select how this schedule will recur. The following 
choices are available: 

• None: The scheduled run is a one-time-only event. 

• Weekly: The scheduled run will occur weekly at the same start time. 

• Monthly: The scheduled run will occur monthly at the same start time. 

• Custom Interval: The scheduled run will occur at a custom interval set by the administrator.  

When done, close all dialogs to save the Parallels Network Discovery configuration settings. 
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Running Parallels Network Discovery 

When Parallels Network Discovery runs, it will perform the following actions:  

1 When discovery finds a Mac, it will add it to SCCM as a resource and will continue searching 
the network. 

2 Parallels Proxy will then connect to the Mac over SSH and will push the Parallels Mac Client 
installation package to it.  

3 The installer will install Parallels Mac Client on the Mac and then enroll it in Configuration 
Manager.  

In a situation when a discovered Mac has Parallels Mac Client already installed, the following 
scenarios will be considered: 

• If the client is registered with a different Parallels Configuration Manager Proxy, but reports the 
same Configuration Manager site code as the current site, the client is re-registered with the 
current Configuration Manager Proxy and the Mac remains to be managed on the current site. 
This scenario may occur when you re-install the Configuration Manager Proxy on your 
Configuration Manager site (e.g. install in on a different computer).   

• If the client is registered with a different Parallels Configuration Manager Proxy and reports a 
different site code, the client registration will remain the same and the Mac will be ignored by 
Network Discovery. This situation may occur when a Mac computer (e.g. a laptop) is managed 
by Parallels Mac Management in one organization and is brought in to another organization that 
also uses Parallels Mac Management to manage their Mac computers. The site code 
comparison allows you to prevent a situation when a Mac is added by mistake to a wrong 
Configuration Manager site. 

The discovered Mac computers are placed into the All Mac OS X Systems collection. Please note 
that if you have secondary sites, Mac computers within their scope will be placed into the same All 
Mac OS X Systems collection on the primary site. For more information, see Collections in 
Parallels Mac Management (p. 77). 
 

Using SCCM Active Directory System Discovery 

SCCM AD System Discovery can discover domain-joined Mac computers. You can configure and 
run the AD System Discovery using the standard SCCM functionality. Once the Mac resources are 
discovered, Parallels Mac Management will automatically identify them as Mac computers and 
push install Parallels Mac Client on them. Active Directory specific properties will persist after the 
Parallels Mac Client installation and will be kept up-to-date by the scheduled runs of AD System 
Discovery.  

Note: Please note that for Parallels Mac Management to push install Parallels Mac Client on Mac 
computers discovered by AD System Discovery, the push installation properties must be configured as 
described in the Configuring Parallels Mac Client Push Installation Properties section (p. 60). 
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Running Parallels Mac Client Installer on a Mac 
This section describes how to manually install Parallels Mac Client on a Mac and enroll the Mac in 
Configuration Manager. 

First, you need to download the Parallels Mac Client installer to the Mac: 

1 Make sure that the Parallels Configuration Manager Proxy service is installed and running. 

2 Log into the computer running the Configuration Manager console.  

3 In the Configuration Manager console, navigate to Administration / Overview / Parallels Mac 
Management / Mac Client Enrollment. 

4 In the Mac Client Enrollment list, right-click the Mac Client installation package download 
URL item and then click Properties in the context menu. 

5 Copy the URL from the Mac Client Installer URL field and give it to the Mac user (e.g. email it). 
The URL will look similar to the following:  

http://myhost.local:8761/files/pma_agent.dmg 

6 The Mac user enters the URL into a Web browser to download the pma_agent.dmg image. 

To install Parallels Mac Client on the Mac: 

1 After the pma_agent.dmg download is complete, double-click it to open the image. 

2 In the Parallels Mac Management for Microsoft SCCM window, double-click the Parallels 
Mac Management for Microsoft SCCM.pkg icon. This will start the installation assistant. 

3 Follow the onscreen instructions. When asked, provide a user name and password. The user 
must be allowed to administer this Mac. 

4 When the installation is complete, click Close to exit the installation assistant. 

After you close the installation assistant, the Mac enrollment wizard will automatically open: 

1 Read the information provided on the Introduction page and then click Continue. 

2 On the Authorization page, enter your organization's domain name (e.g. 
Example.CompanyName.com), your domain username (e.g. UserName) and password. Please 
note that the username should contain the domain logon name only. It should NOT contain the 
domain name separated by a slash or the "@" sign. 

3 Click Continue. 

4 If you receive an error, click the Try Again button to return to the Authorization page and re-
enter the information. The registration may fail for the following reasons: 

• The specified domain name and/or domain credentials are incorrect. 

• The Mac IP address falls outside the boundary defined in Configuration Manager. 

• The Configuration Manager Proxy service is not running. 
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If you close the wizard without completing the enrollment, it will run automatically at predefined 
intervals (5-10 minutes) and every time you restart the Mac. To stop this from happening, either 
resolve the problem and enroll the Mac or uninstall Parallels Mac Client (p. 70). 

5 If firewall is enabled in OS X, a message will be displayed asking you if pma_agent.app 
should be allowed to accept incoming connections. Click Allow. This will add 
pma_agent.app to the firewall exception list. 

The results of a successful client registration should be as follows: 

• The Mac is enrolled in Configuration Manager. 

• The Mac inventory is collected and saved in the Configuration Manager. 

• The Mac is added to the All Mac OS X Systems collection in the Configuration Manager 
console. 

Once installed, Parallels Mac Client will run on a Mac in the background and will start automatically 
every time the Mac is restarted. 
 

Installing Parallels Mac Client Using a Script 
A special script is supplied with Parallels Mac Management that you can use to perform an 
unattended Parallels Mac Client installation.  

To obtain and use the script, follow these steps: 

1 On the computer running Parallels Configuration Manager Proxy, navigate to the C:\Program 
Files (x86)\Parallels\Parallels Mac Management for Microsoft 
SCCM\files directory. 

2 Locate the InstallAgentUnattended.sh file and copy it to a Mac. Copy the file to a Mac. 
Alternately, you can use Apple Remote Desktop to run the script on a Mac remotely. 

3 Please note that you must use sudo to run the script because enrolling a Mac in Configuration 
Manager requires superuser privileges. 

When you run the script, provide the following parameters (in the order listed): 

• agent_download_url — the URL of the Parallels Mac Client installer. The URL can be 
obtained in the Configuration Manager console as described in Manually Installing 
Parallels Mac Client. 

• user_name — specifies the name of a domain user account that will be used to register 
Parallels Mac Client with the Configuration Manager Proxy. Please note that that the name 
must contain the domain logon name (e.g. UserName). It must NOT contain a domain name 
separated by a slash or an at (@) sign. 

• user_password — the domain user password.   

• domain_name — your company's domain name. 
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Example: 
$ sudo ./InstallAgentUnattended.sh http://myhost.local:8761/files/pma_agent.dmg 
myname mypass mydomain 

If you receive the "Permission denied" error when executing the script, run the following 
command to set the file permissions and then execute the script again: 
$ chmod 755 InstallAgentUnattended.sh 

If you wish, you can hard code the URL, user/password, and the domain parameter values in the 
script, so you (or the Mac user) won't have to enter them in the command line. To hard code the 
parameter values, open the script in an editor and change the values of the input parameters from 
$1, $2, $3, $4 to the desired values. The parameter names in the script are self-explanatory. Once 
the script is ready, give it to your Mac users, so they can execute it on their Mac computers, or use 
Apple Remote Desktop to execute it on Mac computers remotely. 

When the script runs on a Mac, it displays the information in the console about the processes that 
its running. When the script completes executing, it returns a numeric code. To see the return 
code, run the following command after the scrip finished executing: 
$ echo $? 

The "0" code returned by the above command indicates that Parallels Mac Client has been installed 
and registered properly. Any other code indicates a failure (you can also read the last messages in 
the console to get an idea of what went wrong). 
 

Push Install or Update Parallels Mac Client 
You can push install or update Parallels Mac Client on Mac computers that are already enrolled in 
SCCM or have been added to it as unmanaged resources. You can use this option to remotely 
repair Parallels Mac Client on a Mac if it's not functioning properly or to enroll Mac computers that 
show up in the Configuration Manager console as unmanaged resources. 

To push install Parallels Mac Client: 

4 In the Configuration Manager console, navigate to the collection containing your Mac 
resources. 

5 Select the desired Mac computers, then right-click on the selection and choose Install 
Parallels Mac Client. 

6 The Push Install Parallels Mac Client wizard opens. 

7 On the first page, specify a user account to connect to Mac computers using one of the 
following options: 

• Use accounts from Parallels Mac Client Push Installation properties. Use this option if 
you have already configured one or more accounts as described in Configuring Parallels 
Mac Client Push Installation Properties (p. 60). 

• Use this account. Specify an account name and password.  This can be a domain account 
or a local Mac account. See Enabling Remote Access on Mac Computers (p. 59) for the 
information on how to configure an account. 
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8 Click Next. 

9 On the second page of the wizard, specify what to do if Parallels Mac Client is already installed 
on a Mac. The following options are available: 

• Install Parallels Mac Client if it is already installed. If you select this option, Parallels Mac 
Client will be re-installed on a Mac over the existing installation. If you clear this option, 
Parallels Mac Client will not be re-installed unless the push installation process finds a re-
installation necessary due to a problem of some sort. 

• Uninstall the existing Parallels Mac Client before installation. This option becomes 
enabled only if you select the option above. If selected, Parallels Mac Client will first be 
uninstalled from a Mac and then a fresh installation will be performed. Note that during the 
uninstallation, the existing Parallels Mac Client state (policies received, software installation 
states, etc.) will be lost. If this option is cleared, the Parallels Mac Client state will be 
preserved. 

10 Click Next. 

11 A dialog opens displaying the progress (number of processed Mac computers). To see more 
information, click Details. To hide the dialog and continue the operation, click Hide. To cancel 
the operation, click Cancel. 

 
 

Configuring the Firewall 
The firewall must be configured on a Mac to allow Parallels Mac Client communicate over network. 
When you manually install Parallels Mac Client, you will be asked if pma_agent.app should be 
allowed to accept incoming connections. You answer "Allow" or "Deny". The same message is 
displayed  when the push installation is performed by network discovery. If you answers "Deny", 
you'll have to add pma_agent.app to the firewall exception list later as described below. 

To add pma_agent.app to the firewall exception list: 

1 From the Apple menu, select System Preferences. The System Preferences dialog opens. 

2 Select Security & Privacy and then click the Firewall tab.  

3 If the firewall is running, the green light indicator will be "on" and its label will read "Firewall: On". 

4 Click Advanced. 

5 Click the + icon. The Mac directory tree dialog opens. 

6 In the directory tree, navigate to the /Library/Parallels folder and select the 
pma_agent.app file. 

7 Click Add and then click OK. 

8 Close the System Preferences window. 
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Verifying Parallels Mac Client Deployment 
To verify that the Parallels Mac Management deployment was successful, open the Configuration 
Manager console and navigate to Assets and Collections / Devices / All Mac OS X Systems. 
You should see some Mac computers in the list. If you ran Parallels Network Discovery to discover 
Mac computers, some of those Mac computers may not have Parallels Mac Client installed on 
them. The possible reasons for this are described in Using Parallels Network Discovery (p. 62).  

To see if a Mac has Parallels Mac Client installed and running on it, look at the Client and Client 
Activity properties, which should say "Yes" and "Active" respectively. If the Client property says 
"No", it means that the Mac cannot be managed in SCCM because Parallels Mac Client is not 
installed on it. If the Client Activity property says "Inactive", the Mac may be turned off, 
disconnected from the network, or it may have some other issues that prevent the Configuration 
Manager to communicate with it. 
 

Updating Parallels Proxy Connection URL 
If you migrate Parallels Configuration Manager Proxy to a different server, its connection URL 
record must be updated on managed Mac computers. Parallels Mac Client is capable of making 
this update automatically as described below. 

Parallels Mac Client running on a Mac connects to the Parallels Configuration Manager Proxy using 
the connection URL that it obtains from the Active Directory during the Parallels Mac Client 
installation. If at some point the client fails to establish a connection with the proxy, it will try to 
recover the connection as follows: 

1 First, it will try to access DNS records for the location of the Configuration Manager Proxy. If it 
finds the new connection URL in DNS, it will use it to connect to the Configuration Manager 
Proxy. 

2 If the location cannot be found in DNS at this time, the client will keep trying to connect to the 
Proxy and to find the new location in DNS for a period of one week.  

3 If after a week the connection still cannot be establish, a dialog box will be displayed in OS X 
asking the Mac user to enter the Active Directory credentials. The client will then connect to the 
Active Directory and try to retrieve the Configuration Manager Proxy connection URL from it. If 
succeeded, the client will use the URL to connect to the Configuration Manager Proxy. If it fails 
again, it will display an error message to the Mac user advising them to contact the system 
administrator. 

For additional information about migrating the Configuration Manager proxy to a different server, 
please see Migrating Configuration Manager Proxy (p. 42). 
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Uninstalling Parallels Mac Client 
To uninstall Parallels Mac Client from a Mac, execute the following command in Terminal: 
$ sudo /bin/bash –с 
/Library/Parallels/pma_agent.app/Contents/MacOS/pma_agent_uninstaller.app/Contents/Reso
urces/UninstallAgentScript.sh 

You can also run the Parallels Mac Client uninstaller in interactive mode as follows: 

1 Open Finder and choose Go > Go to Folder.  

2 Type /Library and click Go. 

3 Locate and open the Parallels folder. 

4 In the Parallels folder, right-click the pma_agent.app file and click Show Package Contents 
in the context menu. 

5 Open the Contents/MacOS folder.  

6 Double-click the pma_agent_uninstaller.app file to start the uninstaller. 

7 Follow the onscreen instructions to uninstall Parallels Mac Client. 

After Parallels Mac Client is uninstalled, the Mac will remain in the Configuration Manager database 
but its management will not be possible. You can reinstall the client on the Mac later to restore 
management functions. 
 

Upgrading Parallels Mac Client 
When you upgrade Parallels Mac Management for Microsoft SCCM, you also need to upgrade 
Parallels Mac Client on every Mac computer on which it is installed. This task can be accomplished 
using one of the following methods: 

1 Enabling the Automatic Parallels Mac Client Update option in the Configuration Manager 
console. This will upgrade Parallels Mac Client on every managed Mac automatically without 
requiring the administrator to take any extra steps. 

2 Distributing the client installation package to Mac computers using the standard SCCM 
software distribution functionality. 

3 Manually uninstalling Parallels Mac Client from a Mac and then installing a new version. 

Each method is described in detail in the following subsections. 
 

Automatic Upgrade of Parallels Mac Client 

Parallels Mac Client can be upgraded automatically when you upgrade Parallels Mac Management 
to a newer version. 
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To use this functionality, the Automatic Parallels Mac Client Upgrade option must be enabled in 
the Configuration Manager console as described below: 

1 Navigate to Administration / Site Configuration / Sites.  

2 Right-click the Sites node and choose Hierarchy Settings. The Hierarchy Settings 
Properties dialog opens. 

 

3 Click the Automatic Mac Client Upgrade tab and select the Upgrade client automatically 
when new client updates are available option.  

After you enable this option, Parallels Mac Client running on a Mac will begin to periodically check 
whether it needs to be upgraded. If you upgrade Parallels Mac Management to a newer version 
while this option is enabled (or prior to enabling it), Parallels Mac Client will be automatically 
upgraded on all managed Mac computers. The Parallels Mac Client registration parameters will be 
inherited from the existing registration file, so you don't have to configure it again. 

Note: It may take up to an hour (or more) for Mac computers to upgrade after Parallels Mac 
Management is upgraded. 

 

Upgrading Parallels Mac Client via Software Distribution 

To upgrade Parallels Mac Client on Mac computers via Software Distribution, do the following: 

1 Obtain the Parallels Mac Client installation image file as described in Manually Installing 
Parallels Mac Client.  
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2 Distribute the client installation image to Mac computers. The Deploying Software via SCCM 
Package Deployment section (p. 113) describes how to accomplish this task.  

Note that when creating a program for the distribution package, the Command Line property 
should be specified as follows: 

:pma_agent.dmg/Parallels Mac Management for Microsoft SCCM.pkg:: 

When you install Parallels Mac Client via software distribution, the client registration parameters will 
be inherited from the existing registration file, so you don't have to configure the client again.  
 

Manually Upgrading Parallels Mac Client 

If you need to upgrade Parallels Mac Client on a single Mac, you can do it manually as follows: 

1 Uninstall Parallels Mac Client from a Mac. See Uninstalling Parallels Mac Client (p. 70). This is 
a necessary step. Please note that when upgrading Parallels Mac Client using the automatic 
upgrade option or the software distribution functionality (described above), the client is 
uninstalled automatically. 

2 Download the Parallels Mac Client installation image and run the installation program as 
described in Manually Installing Parallels Mac Client. 

 

Using Parallels Mac Client Tools 
Parallels Mac Client includes useful tools that can be run from System Preferences. This chapter 
describes how to use them. 
 

Viewing Parallels Mac Client Properties 

The Parallels Mac Client properties window allows you to see the Mac Client properties, send a 
problem report, and retrieve policies from Configuration Manager. 

To open the Parallels Mac Client properties window: 

1 In OS X, open System Preferences. 
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2 Click the Parallels Mac Management icon (or click VIew > Parallels Mac Management for 
Microsoft SCCM). 

 

3 The client properties window opens. 

 

4 The General box contains the following Parallels Mac Client properties: 

• Certificate expiration date. The date and time when the Parallels Mac Client certificate 
expires. 

• Certificate subject name. A globally unique name identifying the Parallels Mac Client for 
which the certificate was issued. 

• Connected to SCCM Proxy. The last date and time the Parallels Mac Client established a 
connection with the Parallels Configuration Manager Proxy. 
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• Policies received. The last time the Parallels Mac Client downloaded its policy. 

• SCCM Proxy URL. The URL of the computer where the Parallels Configuration Manager 
Proxy is running. This is the Parallels Configuration Manager Proxy with which this Parallels 
Mac Client is registered. 

• Site code. The code of the Configuration Manager site to which this Mac is assigned. 

• Unique identifier. A globally unique ID assigned to this Parallels Mac Client instance. 

• Version. The Parallels Mac Client version number. 

5 The buttons at the bottom of the window are: 

• Connect. When clicked, connects to the Parallels Configuration Manager Proxy and 
downloads the latest policy from Configuration Manager. For more information, please see 
Initiating Policy Retrieval below. 

• Send Problem Report. Click this button to send a problem report to Parallels Support. For 
more information, please see Sending Problem Reports from Parallels Mac Client below. 

 

Initiating Policy Retrieval from a Mac 

Parallels Mac Client downloads its policy from Configuration Manager on a schedule. There may be 
a need to download the latest policy before the scheduled download occurs. Parallels Mac Client 
provides you with this ability. 

Using the Client Properties Dialog to Initiate Policy Retrieval 

To initiate policy retrieval: 

1 In System Preferences, click the Parallels Mac Management icon (or click VIew > Parallels 
Mac Management for Microsoft SCCM). 

2 Click the Connect button to initiate policy retrieval. A text will appear next to the button 
informing you of the progress.  

3 If the connection to Configuration Manager was successful, the text will say "Connected" and 
will specify how many policy updates have been received.  

4 The Policies received property in the General list box will be updated if at least one update 
has been received. The property will remain unchanged if no updates are available. 

Initiate Policy Retrieval from the Command Line 

To initiate policy retrieval from the command line, open Terminal, change directory to 
/Library/Parallels/pma_agent.app/Contents/MacOS and type the following 
command: 
$ ./pmmctl get-policies 

On completion, the command returns one of the following XML documents depending on the 
result. 
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If policy retrieval failed: 
<plist version="1.0"> 
    <dict> 
        <key>ErrorCode</key> 
        <integer>3</integer> 
        <key>ErrorMessage</key> 
        <string>Operation timed out</string> 
    </dict> 
</plist> 

where the <integer> element contains the error code, and the <string> element contains the 
error description.  

If policy retrieval was successful: 
<plist version="1.0"> 
    <dict> 
        <key>ErrorCode</key> 
        <integer>0</integer> 
        <key>ErrorMessage</key> 
        <string>No error</string> 
 <key>NumberOfPolicyUpdates</key> 
 <integer>5</integer> 
    </dict> 
</plist> 

where the <integer> value of the <NumberOfPolicyUpdates> key contains the number of 
policy updates retrieved. 

To obtain the list of possible error codes with descriptions, use the following command: 
$ pmmctl error-info 

The command returns the following list: 
0: No error 
1: Invalid command 
2: Operation failed 
3: Operation timed out 
4: Connection aborted 
5: Unknown error code 5 
 

Sending Problem Reports From Parallels Mac Client 

If you are experiencing a problem with Parallels Mac Client, you can obtain a problem report and 
then send it to Parallels Support. To obtain a report: 

1 In System Preferences, click the Parallels Mac Management icon (or click VIew > Parallels 
Mac Management for Microsoft SCCM). 

2 Click the Send Problem Report button to obtain a report. The Send Problem Report dialog 
opens and the report data gathering process begins.  
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3 Once the report file is generated, a message is displayed in the dialog specifying its location on 
the local hard drive. Clicking the Send button will send the report to the Parallels Configuration 
Manager Proxy, which will notify the IT administrator through the Problem Monitoring utility. The 
Problem Monitor can then be used to view the report summary and to send it to Parallels 
Support. 

The problem reporting utility can also be run from Finder as follows: 

1 Open Finder and navigate to the /Library/Parallels/ folder.  

2 Locate the pma_agent.app package, right-click it and select Show Package Contents.  

3 In the package, navigate to the Contents/MacOS folder and double-click the 
pma_report_tool file.  

4 The Send Problem Report dialog opens. This is the same dialog as the one that opens when 
you click the Send Problem Report button described above. 

 



 

 

This chapter describes how to use the Parallels Mac Management features. 
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The Configuration Manager Admin Console 
Parallels Mac Management for Microsoft SCCM extends the Configuration Manager console with 
support for Mac computers. The Configuration Manager console is the primary interface to manage 
Mac computers in your enterprise. After you install Parallels Mac Management, the Mac-specific 
GUI elements are integrated into the console allowing you to accomplish Mac management tasks. 
 

Device Collections in Parallels Mac Management 
Configuration Manager collections help IT administrators to manage resources by combining them 
into logical groups based on a certain criteria. Parallels Mac Management adds the All Mac OS X 
Systems collection to organize Mac computers and the Unknown Mac OS X Systems collection 
that's used for OS X deployment. 

C H A P T E R  5  

Using Parallels Mac Management for 
Microsoft SCCM 
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To see the All Mac OS X Systems collection, open the Configuration Manager console and 
navigate to Assets and Compliance / Overview / Device Collections / All Mac OS X Systems. 
The collection can contain both managed and unmanaged Mac computers. A Mac is added to a 
collection as an unmanaged resource if Parallels Mac Client is not installed on it or if it's not 
registered with the Configuration Manager Proxy. You can still view the properties of an 
unmanaged Mac and connect to it using SSH or VNC if needed. 

To identify managed and unmanaged Mac resources in the All Mac OS X Systems collection: 

1 Right-click a resource and select Properties from the context menu.  

2 In the Properties dialog, select the General tab.  

3 In the Discovery data list, look up the "Client Version" property: 

• The client version of a managed resource will contain the Parallels Mac Client version 
number followed by "-PMA". For example: "5.1.6.804674-PMA".  

• The client version of an unmanaged resource will be "Unknown-PMA". 

The All Mac OS X Systems collection uses the following criteria in the WHERE clause of its SQL 
statement: 

ClientVersion LIKE '%-PMA' 

Therefore, the Mac resources that have the client version ending with "PMA" are displayed in the 
All Mac OS X Systems collection. You can create your own collections for Mac resources using a 
different criteria if needed. 

Unknown Mac OS X Systems is a special collection to which you deploy task sequences as part 
of OS X deployment. The collection is not supposed to contain any devices. For more information, 
see Operating System Deployment (p. 127). 
 

Hardware and Software Inventory 
Hardware and software inventory information is collected from enrolled Mac computers on a 
schedule and is saved in the Configuration Manager database. In addition to scheduled inventory 
gathering, you can request an inventory update manually. 

To view the collected hardware and software inventory: 

1 Open the collection containing Mac resources (e.g. All Mac OS X Systems). 

2 Right-click a Mac of interest and select Start > Resource Explorer in the context menu.  

3 The Resource Explorer snap-in opens where you can browse the inventory categories 
(classes) and view the relevant hardware and software information. 

To request an unscheduled inventory update: 
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1 In the Configuration Manager console, open the device collection containing your Mac 
computers. 

2 Select one or more Mac computers (or the entire collection), then right-click on a selection and 
choose Request Inventory Update. 

3 A dialog opens displaying the progress (number of processed Mac computers). To see more 
information, click Details. To hide the dialog and continue the operation, click Hide. To cancel 
the operation, click Cancel. 

4 Once the operation is completed, you can view hardware and software inventory as described 
above. 

 

Reporting User Logon Information 

Mac user logon details are reported by the Parallels Mac Client to SCCM and are saved in 
hardware inventory. The logon information is reported using the standard nodes in the hardware 
inventory tree, which are described below. 

Computer System 

This node reports general computer information along with names of currently logged on users. The 
User Name column contains the user name in the qualifier\account format, where qualifier 
is the computer’s NetBIOS name or a domain name. If there's no currently logged on user, the 
column will contain SYSTEM as a value. 

 

Network Login Profile 

This node reports all existing local user accounts (even if they haven't logged on recently) and all 
domain users who have logged on in the last 90 days. Each row in the list represents the network 
login profile of a specific user: 
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• The Name column contains the name of the account on a domain or the computer. 

• The Full Name column contains the full name of the user belonging to the network login profile. 

• The Home Directory column contains the path to the home directory of the user. 

• The Last Logoff and Last Logon columns indicate date and time the user last logged off the 
system and logged on to system respectively. 

• The Number of Logons column indicates the number of successful times the user tried to log 
on to this account. 

 

System Console User 

This node allows you to easily see the top console user, which is the user who spends the most 
time logged on to the console. The information reported here is gathered from the OS X user 
accounting database by using logon and logoff events. When matching logon and logoff events are 
found, the information is used to calculate the amount of time the user was logged on. The 
resulting information is aggregated by user and ordered by total console usage. The information is 
calculated and displayed for the last 90 days. 

• The Last Console Use column contains the last date and time when the user logged off from 
the console. 

• The Number Of Console Logins column contains the total number of logons recorded in the 
user accounting database for the specific user. 

• The System Console User column contains the user name for the user logged on to the 
console. 
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• The Total User Console Minutes column contains the total number of console logon minutes 
recorded in the database for the user. 

 
 

Compliance Settings 
Compliance settings is a set of tools that allow you to assess the compliance of Mac computers in 
your organization with regard to whether OS X is configured correctly, volumes on Mac computers 
are encrypted, and whether Parallels Desktop (if installed) is configured properly. Compliance is 
evaluated by creating a configuration baseline that contains configuration items that you want to 
evaluate.  

This section contains information about how to create configuration items, set up a configuration 
baseline, and then deploy the baseline to a device collection.  
 

Deploying OS X Configuration Profile 

Parallels Mac Management for Microsoft SCCM provides you with the functionality to monitor and 
enforce OS X configuration settings on Mac computers.  

First, you need to create an OS X configuration profile using one of the following options: 

• Using a custom OS X profile editor. The editor is provided by Parallels Mac Management and is 
integrated in the Configuration Manager console. 

• Creating a profile from a .mobileconfig file that can be created using the OS X Server's 
Profile Manager. 

 

Creating OS X Configuration Profile Using Profile Editor 

To create an OS X configuration profile using the profile editor: 
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1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Compliance Settings / Configuration Items. 

2 Right-click Configuration Items, point to Create Parallels Configuration Item, and then click 
Mac OS X Configuration Profile. 

3 The Mac OS X Configuration Profile dialog opens. 
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The left pane of the dialog contains the list of payloads. The right pane contains the settings for a 
selected payload. When you select a payload for the first time, the right pane will only contain a 
short description and the Configure button.  
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Clicking the Configure button will show the configurable properties for the selected payload. 

 

Specify the desired payload properties and continue to another payload. Click OK at any time to 
save the changes and close the dialog. 

If you don't specify any values for a payload, it will be excluded from the configuration profile and 
will not be evaluated on Mac computers. If you configured a payload but would like to remove it 
from the profile, click the X icon in the payload header area. 

Allowing Users to Specify Mac OS X Profile Settings 

When setting up an OS X profile for multiple users, it may not be possible to specify all of the 
settings in advance. For example, when configuring the Exchange payload, the user account, 
email address, and password must be specified individually for each user. In a case like this, you 
may allow Mac users to provide the required settings interactively when the profile is applied on a 
Mac.  

Some of the editable fields on payload screens are marked in light gray as required, set on device, 
and optional. Required fields must have a value or you will not be able to save the profile. "Set on 
device" fields can be mandatory or optional, and are usually set on a Mac by the Mac user (e.g. 
user names and passwords). 
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The logic that determines whether the profile is applied on a Mac interactively or silently is as 
follows: 

• To use the interactive mode, enter the %user_interaction_required% tag into a field 
instead of a value. If a payload contains this tag in at least one field, a Mac user will be 
prompted to manually enter all of the missing settings. The interactive mode will be used even if 
none of the missing settings are actually required on the OS X side. You can enter the 
%user_interaction_required% tag into any field that you want a user to set manually, 
including the required, set-on-device, and optional fields. 

• If a payload does not contain the %user_interaction_required% tag, an attempt will be 
made to apply the profile on a Mac silently. If the profile cannot be applied silently (one or more 
settings that are required on the OS X side are missing), the interactive mode will be used and 
the user will have to specify them manually. 

In interactive mode, a standard System Preferences dialog will be opened in OS X for each 
corresponding payload where the user will have to specify the required settings. The dialog has the 
Install and Cancel buttons. To apply the settings, the user clicks the Install button. If the specified 
values don't pass validation, the user will have to enter them again. On success, a report will be 
sent to SCCM. If the user clicks the Cancel button, the profile installation is aborted and a report is 
sent to the administrator. 

Please note that when you create an OS X configuration profile using the Profile Manager, you have 
an option to set the Profile Distribution Type to Automatic Push or Manual Download. When 
you use the profile editor in the Configuration Manager console (described in this section), the 
distribution type is always Manual Download. The requirements for specifying certain settings are 
not as strict with the Manual Download distribution type.  

Payload Overview 

The first item in the payload list is Configuration Item. It's not really a payload and is used to 
specify a configuration item name and optional description. This is the name that will appear in the 
Configuration Items list in the Configuration Manager console after you save the profile. 

The General payload (second in the list) is used to specify general information for the configuration 
profile. 

The rest of the payloads are used to specify the corresponding OS X system preferences. The 
following list provides a general description of each payload. For the complete information about 
creating an OS X configuration profile, please refer to Apple documentation. 

Payload Description 

Passcode Used to specify passcode policies.  

Exchange Exchange account configuration. 

Dock Dock item settings. Dock appearance settings. 

Contacts Contacts LDAP configuration (CardDAV). 

Calendar Calendar server account configuration (CalDAV). 
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Network Network Interface (Ethernet or Wi-Fi). 

Certificate X.509 certificates. 

Security & Privacy Usage and diagnostic information opt-out. 

Saving the Configuration Profile 

When you are finished entering the configuration profile information, click the OK button. This will 
create a configuration item that will appear in the Configuration Items list in the Configuration 
Manager console. Press F5 to refresh the list.  

To edit the profile, right-click it and select Edit Parallels Configuration Item from the context 
menu. 

To evaluate Mac computers for compliance, you need to add the configuration item to a baseline 
and then deploy it to a Mac collection. See Deploying Configuration Baseline (p. 111) for more 
information. 
 

Creating OS X Configuration Profile from .mobileconfig File 

Alternately, you can create an OS X configuration profile from a .mobileconfig file that was 
created using OS X Server Profile Manager. You can use this approach if you already have this file 
or if you prefer to use Profile Manager for any reason. For supplementary information, see Using 
Profile Manager at the end of this section. 

To create a Mac OS X Configuration Profile configuration item from a .mobileconfig file: 

1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Compliance Settings. 

2 Right-click Configuration Items and then point to Create Parallels Configuration Item and 
click Mac OS X Configuration Profile from File. 
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3 The Mac OS X Configuration Profile dialog opens. 

 

4 Enter a configuration item name and description. 

5 Select the profile type from the following options: 

• User profile. Select this option if you want to install the configuration profile using the 
current user's security context. 

Note: The System Policy Control payload (designated by specifying 
com.apple.systempolicy.control as the PayloadType) must only exist in a device 
profile. If the payload is present in a user profile, an error will be generated during installation and 
the profile will fail to install.  

• System profile. Use this option when you want to install the configuration profile as root. 

6 Click the Browse button, select a .mobileconfig file, and click Open. 

7 Click OK to save the configuration item. The new configuration item is created with the XML 
content of the configuration profile embedded into it. Press F5 to refresh the Configuration 
Items list to see the new item. 

8 To edit the profile, right-click it and select Edit Parallels Configuration Item from the context 
menu. The Mac OS X Configuration Profile dialog will now have the Import from 
.mobileconfig and Export to .mobileconfig buttons. Using these two buttons, you can export 
the profile into a file, edit it in an external application (e.g. Profile Manager) and then import it 
back into the configuration item.  
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The import operation will perform the following validations of the profile data: 

• The profile type (User or System) must be the same as the original. 

• If this is a signed profile, the payload identifier must be the same as the original. 

• If the profile is not signed but the payload identifier differs from the original, a message box 
containing this information will be displayed. You'll have an option to cancel or continue the 
importing operation. 

To evaluate Mac computers for compliance, you need to add the configuration item to a baseline 
and then deploy it to a Mac collection. See Deploying Configuration Baseline (p. 111) for more 
information. 

Using Profile Manager 

Profile Manager is a tool provided by Apple that allows you to create an OS X configuration profile 
(an XML file) containing the configuration settings that your organization requires. The configuration 
profile can then be deployed to Mac computers to configure them using the specified settings. 

Note: You need a Mac with an OS X Server installed to use the Profile Manager. 

To create a configuration profile using Profile Manager:  

1 Log into your OS X Server. 

2 Open Services and find "Profile Manager" in the service list. 

3 Click the On button to start the service. 

4 In a Web browser, enter the URL for Profile Manager (e.g. 
http://my_server.com/profilemanager/). 

5 Log into Profile Manager using an administrator account.  

6 In the Library, select the profile and click the Edit button to edit it. For a complete information 
about individual profile settings, see the documentation that comes with Profile Manager. 

When setting up a profile for multiple users, it may not be possible to specify all of the settings in 
advance. For example, when configuring the Exchange payload, the user account, email address, 
and password must be specified individually for each user. In a case like this, you may allow Mac 
users to provide the required settings interactively when the profile is applied on a Mac. The logic 
that determines whether the profile is applied on a Mac interactively or silently is as follows: 

• To use the interactive mode, enter the %user_interaction_required% tag into a field 
instead of the actual value. If a payload contains this tag in at least one field, the Mac user will 
be prompted to manually enter all of the missing settings. The interactive mode will be used 
even if none of the missing settings are actually required on the OS X side. You can enter the 
%user_interaction_required% tag into any field that you want a user to set manually. 
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• If a payload does not contain the %user_interaction_required% tag, an attempt will be 
made to apply the profile on a Mac silently. If the profile cannot be applied silently (one or more 
required settings are missing), the interactive mode will be used and the user will have to 
specify them manually. 

In the interactive mode, a standard System Preferences dialog will be opened in OS X for each 
corresponding payload where the user will have to specify the required settings. The dialog has the 
Install and Cancel buttons. To apply the settings, the user clicks the Install button. If the specified 
values are invalid, the user will have to enter them again. On success, a report will be sent to 
SCCM. If the user clicks the Cancel button, the profile installation is aborted and an appropriate 
report is sent to the administrator. 

When you save the configuration profile, Profile Manager creates a file with the ".mobileconfig" 
extension. The file is an XML document containing the OS X configuration settings that you 
specified. Copy the file to a location where the Configuration Manager console can access it (e.g. a 
directory on the server running the Configuration Manager console). 
 

Enforcing FileVault 2 Encryption 

FileVault 2 is an encryption method that can be used with volumes on Mac computers to keep their 
data secure.   

Before creating a FileVault 2 configuration item, you need to decide whether you want to use an 
institutional or a personal recovery key. The following explains what these keys are.  

When preparing to encrypt the disk, the Mac user is asked to specify a password that will be used 
to unlock an encrypted disk. If the user forgets the password, he/she will not be able to log into the 
computer. The recovery key is a "safety net" that can be used to unlock the disk if the user forgets 
the password. 

When creating a FileVault 2 configuration item, choose the key type: 

• Institutional. An institutional recovery key is created in advance by the system administrator 
and then used for all Mac computers being encrypted. The key is stored in a keychain file, 
which the system administrator should keep in a safe place. If a Mac user forgets his or her 
personal password for unlocking the disk, this recovery key can be used to unlock it. 

• Personal. A personal recovery key is created automatically for each individual Mac during the 
encryption procedure and is saved in the database on the primary SCCM site (p. 196). If a Mac 
user forgets the password for unlocking the disk, the personal recovery key for the disk can be 
retrieved from the database and can be used to unlock the disk. 

Based on the type of the recovery key that you would like to use, read one of the following topics to 
learn how to create a FileVault 2 configuration item: 

• FileVault 2 Encryption with Institutional Recovery Key (p. 90) 

• FileVault 2 Encryption with Personal Recovery Key (p. 97) 
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FileVault 2 Encryption with Institutional Recovery Key 

This section describes how to create a FileVault 2 configuration item using an institutional recovery 
key. 
 

Creating FileVaultMaster Keychain 

To use an institutional recovery key on multiple Mac computers, you need to create a 
FileVaultMaster keychain file. The file will contain a recovery key (private key) needed to recover a 
disk encrypted with FileVault 2 and a public certificate. 

To create a FileVaultMaster keychain, run the following command in Terminal (the command is 
available in OS X 10.7.2 or later): 
$ security create-filevaultmaster-keychain /path/to/FileVaultMaster.keychain 

You can omit the target path and filename if you want to create the 
FileVaultMaster.keychain file in the default /Users/user-name/Library/Keychains 
directory. 

When prompted, choose and enter a password for the new keychain, This will become your master 
password. After the keychain is created, make one or more backup copies of the 
FileVaultMaster.keychain file and store them in a safe location, such as an external drive or 
an encrypted volume. 

You now need to export the X.509 asymmetric public certificate from the FileVaultMaster keychain 
to a DER encoded certificate file. 

To export the certificate: 

1 Run the Keychain Access application (Applications/Utilities). 

2 In the Keychain Access window, select "FileVaultMaster" keychain in the Keychains panel. 

3 In the right pane, right-click the "FileVault Recovery Key" certificate and then click Export in the 
context menu. 

4 Choose the name and location for the new file. Make sure that the File Format field has 
"Certificate (.cer)" option selected. 

5 Click Save to export the certificate. 

6 Copy the exported .cer file to a location where it can be accessed from the computer running 
the Configuration Manager console. You will later add this file to a configuration item to be 
distributed to Mac computers. 

 

Creating FileVault 2 Configuration Item 

o create a FileVault 2 configuration item using an institutional recovery key: 
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Note: If you want to use a personal recovery key, jump to FileVault 2 Encryption with Personal 
Recovery Key (p. 97). 

1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Compliance Settings. 

2 Right-click Configuration Items and then point to Create Parallels Configuration Item and 
click FileVault 2 Configuration Item. 

 

3 Enter a configuration item name and description. 

4 Select Institutional as key type. Please note that once a volume on a Mac has been encrypted, 
you will not be able to modify the following: 

• You cannot switch between personal and institutional recovery key. 

• You cannot change the existing FileVault 2 public key by providing another key file. 

5 Click OK to create the configuration item. 

To evaluate Mac computers for compliance, you need to add the configuration item to a baseline 
and then deploy it to a device collection. See Deploying Configuration Baseline (p. 111) for more 
information. 
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Viewing and Monitoring FileVault 2 Encryption Status 

When the disk encryption operation is initiated on a Mac, the Parallels Mac Client begins reporting 
the encryption status to the Parallels Configuration Manager Proxy. The current encryption status is 
saved in the Mac's hardware inventory record in Configuration Manager and can be viewed in the 
Configuration Manager console. If at some later point the Mac user (or a third-party program) 
encrypts, decrypts, or re-encrypts the disk, the Parallels Mac Client running on a Mac will detect it 
and the encryption status will be immediately updated. 

You can view the FileVault 2 encryption status for a particular Mac or you can run a report and view 
the information for all Mac computers as a single list. 

Viewing the FileVault 2 Status for a Specific Mac 

1 In the Configuration Manager console, open the collection containing Mac computers (e.g. All 
Mac OS X Systems). 

2 Right-click a Mac and select Start > Resource Explorer from the context menu. The 
ResourceExplorer window opens.  

3 In the resource tree, navigate to Hardware / FileVault 2 Disk Encryption. The encryption 
information for the Mac is displayed in the right pane. 

A single row of information represents a corresponding Mac volume and contains the following 
columns: 

• Key Type — the type of the recovery key that was assigned or created during encryption. The 
possible values are: 

• Unknown — the disk is not encrypted or the disk is encrypted by the Mac user or a third-
party (see the Status column). 

• Personal — personal recovery key. 

• Institutional — institutional recovery key. 

• Status — the current encryption status. The possible values are described in the table below. 

• Volume — the volume name. 

Viewing the FileVault 2 Disk Encryption Report 

In the Configuration Manager console, navigate to Monitoring / Reporting / Reports. Locate the 
FileVault 2 Disk Encryption report and double-click it. The FileVault 2 Disk Encryption dialog 
opens displaying the report.  

Each row in the report represents a corresponding Mac volume and contains the following 
columns: 

• Netbios Name — the Mac netbios name. 

• Volume — the volume name. 
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• Status — the FileVault 2 encryption status (see the table above). 

• Key Type — the recovery key type (Unknown, Personal, or Institutional). 

• Time — the date and time the record was last updated. 

The following table lists all possible FileVault 2 encryption states and transitions: 

State/Transition   Description 

FileVault 2 is Off FileVault 2 is not enabled on the Mac. 

Encryption initiated, waiting for reboot FileVault 2 encryption is in progress. The Mac is about to be 
rebooted to complete the encryption. 

Encryption in progress Encryption is in progress. 

Encrypted The Mac has been encrypted with FileVault 2. 

Decrypting Decryption is in progress. 

Decrypting finished, waiting for reboot Decryption finished. The Mac is about to be rebooted to 
complete the decryption. 

Decrypted The Mac has been decrypted. 

Encrypting in progress by a 3rd party An encryption operation has been initiated on the Mac by the 
user or a third-party program. 

Encrypted by a 3rd party The Mac has been encrypted by the user or a third-party 
program. 

Decrypting (after 3rd party encrypting) 

A decryption operation is in progress. The original encryption 
was performed by the Mac user or a third-party program. The 
decryption has also been initiated  by the user or a third-party 
program. 

Decrypting finished (after 3rd party 
encrypting), waiting for reboot 

The Mac has been decrypted. The original encryption was 
performed by the Mac user or a third-party program. The 
decryption was also performed by the user or a third-party 
program. The Mac is about to be rebooted. 

After Mac computers have been encrypted, the best way for the IT administrator to monitor the 
Mac encryption status is to configure a baseline containing a FileVault 2 configuration item to run as 
often as necessary (e.g. daily). If an unauthorized change is made to the FileVault 2 encryption, the 
baseline run will report an error to Configuration Manager. The IT administrator will be able to see it 
and check the hardware inventory record for a particular Mac. 

Note: You should be aware of one scenario when the FileVault 2 encryption status may not be reported 
accurately in the Mac hardware inventory. This will happen when (a) a Mac is removed from the 
Configuration Manager site, (b) the Parallels Mac Client is uninstalled from it, and (c) the Mac is then 
assigned to the site again. If the Mac was encrypted with FileVault 2 prior to removing it from the site, the 
encryption status will be reported as Encrypted by a 3rd party. To make the status to report accurately, 
you'll need to decrypt the disk and then encrypt it again. 
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Encrypting a Mac with FileVault 2 

After you deploy a configuration baseline to a device collection, Mac computers in the collection will 
be evaluated for compliance. If FileVault 2 is already enabled on a Mac, no action will be performed 
on it. If FileVault 2 is not enabled, the Mac user will see a message box saying that the Mac is about 
to be encrypted. The dialog has two buttons: Encrypt and Postpone:  

• If the user clicks Encrypt, another dialog opens where the user must select one or more OS X 
user accounts that will be allowed to unlock the disk after it is encrypted.  

Note: The dialog displays all user accounts that exist on this Mac, but the user needs to select only 
those accounts that should be allowed to unlock the disk. If more accounts are added to the Mac later, 
they will not have this privilege. To grant the privilege to the new account(s), the disk encryption must be 
removed and then the encryption procedure must be performed from the beginning. 

To select an account, the user needs to click the Enable button next to the account name and 
then enter a password that will be used to unlock the encrypted disk. The user can enable 
multiple OS X user accounts if needed, but at least one account must be enabled to continue. 
When the necessary accounts are enabled, the user clicks Encrypt to enable FileVault 2. To 
perform the actual encryption, the user must restart the Mac. 

• If the user postpones the encryption on the first dialog, the dialog will open again in 5 minutes. 
The user has the ability to keep postponing the encryption procedure indefinitely. The time 
period after which the dialog is displayed is doubled each time the user clicks Postpone, but 
will never exceed one hour. 

 

Recovering Encrypted Disk Using a Password 

If a FileVault 2 encrypted disk becomes unbootable, you will need to unlock it. The following steps 
describe how to unlock an encrypted disk using a password of an OS X account that's authorized 
to unlock the encryption. 

To unlock an encrypted disk: 

1 Boot your Mac from the Recovery HD partition by holding down Command –R. 

2 Use the following command to list the available Core Storage volumes: 
$ diskutil cs list 

3 Look for the UUID of a Logical Volume, usually the last in the list. Select and copy the UUID to 
be used in the next step. 

4 Use the following command to unlock the disk. Be sure to insert the UUID from the previous 
step: 
$ diskutil corestorage unlockVolume UUID -stdinpassphrase 

5 When asked, enter the password of an account that's authorized to unlock the disk. 

6 If successful, the drive will unlock and mount. You'll be able to back up the data using Disk 
Utility, or by using a command line tool such as ditto. 

7 Once the disk is unlocked, you can decrypt it by executing the following command:  
$ diskutil corestorage revert UUID -stdinpassphrase 
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Once the volume is decrypted, you'll have full access to the hard disk. 

 
 

Recovering Encrypted Disk Using Institutional Key 

Normally, you unlock an encrypted disk using a password of an authorized OS X account. 
Alternately, you can unlock an encrypted disk using a recovery key. For instance, this could be the 
only option if the user forgets the password. 

To unlock an encrypted disk using an institutional recovery key, you need the original 
FileVaultMaster.keychain file that contains the recovery key. You must also know the master 
password that you've set when you created the file. 

Finding the Correct FileVaultMaster.keychain File 

If you have more than one FileVaultMaster.keychain file and you forgot which one is which, you can 
compare the SHA1 fingerprint of the certificate in the file to the fingerprint of the original certificate 
that Parallels Mac Management has saved in its database (p. 196). If you know exactly which file 
contains the correct recovery key, skip this and the following sub-sections and read the Unlock the 
Disk Using the Institutional Recovery Key sub-section that follows them. 

To retrieve the SHA1 fingerprint of the original certificate that used during encryption: 

1 In the Configuration Manager console, navigate to the device collection containing the Mac (e.g. 
All Mac OS X Systems). 

2 Locate the Mac in the list. If you can't find the Mac, read If You Can't Find the Mac in Any of 
the Collections below.  

3 Right-click the Mac and then click Properties. 

4 In the Properties dialog, click the FileVault 2 tab to view the FileVault 2 encryption information 
for the Mac. The properties are: 

• Hardware ID. Contains the Mac hardware ID. 

• Serial Number. Contains the Mac serial number. 

• Personal Key. Contains the personal recovery key (will be blank if an institutional key was 
used). 

• Institutional key. Contains the SHA1 fingerprint of the institutional key certificate (will be 
blank if a personal key was used). 

• LVGUUID. The UUID of the logical volume group. 

• LVUUID. The UUID of the logical volume. 

• PVUUID. The UUID of the physical volume. 

5 Compare the value of the Institutional key property to the fingerprint of the certificate in a 
FileVaultMaster.keychain file. The file that has the matching fingerprint contains the correct 
institutional recovery key. 
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If You Can't Find the Mac in Any of the Collections 

If the Mac is no longer assigned to the Configuration Manager site (i.e. you can't find it in any of the 
device collections), you can still retrieve its FileVault 2 encryption info from the Parallels Mac 
Management database (p. 196). The FileVault 2 encryption records are never deleted even for Mac 
computers that are no longer assigned to the site.  

To retrieve the FileVault 2 encryption info for an unassigned Mac: 

1 In the Configuration Manager console, navigate to Assets and Compliance / Parallels Mac 
Management.  

2 Right-click FileVault 2 Encryption Information and then click Properties.  

3 In the FileVault 2 Encryption Information dialog, enter the Mac's serial number of hardware 
ID. Click Search. 

4 If the Mac was previously encrypted through Parallels Mac Management, a dialog will open 
containing the FileVault 2 encryption properties for this Mac. 

5 Use the value of the Institutional key property to compare it to the SHA1 fingerprint of the 
certificate in a FileVaultMaster.keychain file. 

Unlock the Disk Using the Institutional Recovery Key 

Assuming that you have the correct FileVaultMaster.keychain file, do the following to unlock the 
encrypted disk: 

1 Boot your Mac from the Recovery HD partition by holding down Command –R. 

2 Connect an external drive containing the original FileVaultMaster.keychain file. 

3 Run Terminal (Application/Utilities). If the keychain is stored in an encrypted disk image, use the 
following command to mount it: 
$ hdiutil attach /path/to/diskImage 

4 Use the following command to unlock the FileVaultMaster.keychain file: 
$ security unlock-keychain /path/to/FileVaultMaster.keychain 

5 Enter the Master Password to unlock the keychain. If the password is accepted, the command 
prompt will return. 

6 Use the following command to list the available Core Storage volumes: 
$ diskutil cs list 

7 Look for the UUID of a Logical Volume, usually the last in the list. Select and copy the UUID to 
be used in the next step. 

8 Use the following command to unlock the encrypted disk. Be sure to insert the UUID from the 
previous step and the correct path to the keychain file: 
$ diskutil cs unlockVolume UUID -recoveryKeychain /path/to/FileVaultMaster.keychain 

9 When the command completes, the volume will be unlocked and mounted. You'll be able to 
back up data using Disk Utility, or by using a command line tool such as ditto. 
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If the command fails, it is possible that the disk was re-encrypted by the Mac user or a third-
party program. You can compare the UUIDs of the volumes displayed by the diskutil cs 
list command to the LVGUUID, LVUUID, and PVUUID values on the FileVault 2 tab of the 
Mac Properties dialog (see the Retrieve Personal Recovery Key subsection above). The 
values should match. If they don't, it means that the disk was re-encrypted, in which case the 
recovery key stored in the keychain file will not work. 

10 Once the disk is unlocked, you can decrypt it by running the following command: 
$ diskutil cs revert UUID -recoveryKeychain /path/to/FileVaultMaster.keychain 

 

FileVault 2 Encryption with Personal Recovery Key 

This section describes how to create a FileVault 2 configuration item using a personal recovery key. 
 

Creating FileVault 2 Configuration Item 

To create a FileVault 2 configuration item using a personal recovery key: 

Note: If you want to use an institutional recovery key, jump to FileVault 2 Encryption with Institutional 
Recovery Key (p. 90). 

1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Compliance Settings. 
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2 Right-click Configuration Items and then point to Create Parallels Configuration Item and 
click FileVault 2 Configuration Item. 

 

3 Enter the desired configuration item name and description. 

4 Select Personal as key type. A personal recovery key will be created automatically for each 
Mac during the encryption operation. Each individual key will be stored in the database on the 
primary Configuration Manager site and can be retrieved and viewed in the Configuration 
Manager console.  

Please note that you cannot switch between personal and institutional keys once the volume on 
a Mac has been encrypted. 

5 Click OK to create the configuration item. 

To evaluate Mac computers for compliance, you need to add the configuration item to a baseline 
and then deploy it to a device collection. See Deploying Configuration Baseline (p. 111) for more 
information. 
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Viewing and Monitoring FileVault 2 Encryption Status 

When the disk encryption operation is initiated on a Mac, the Parallels Mac Client begins reporting 
the encryption status to the Parallels Configuration Manager Proxy. The current encryption status is 
saved in the Mac's hardware inventory record in Configuration Manager and can be viewed in the 
Configuration Manager console. If at some later point the Mac user (or a third-party program) 
encrypts, decrypts, or re-encrypts the disk, the Parallels Mac Client running on a Mac will detect it 
and the encryption status will be immediately updated. 

You can view the FileVault 2 encryption status for a particular Mac or you can run a report and view 
the information for all Mac computers as a single list. 

Viewing the FileVault 2 Status for a Specific Mac 

1 In the Configuration Manager console, open the collection containing Mac computers (e.g. All 
Mac OS X Systems). 

2 Right-click a Mac and select Start > Resource Explorer from the context menu. The 
ResourceExplorer window opens.  

3 In the resource tree, navigate to Hardware / FileVault 2 Disk Encryption. The encryption 
information for the Mac is displayed in the right pane. 

A single row of information represents a corresponding Mac volume and contains the following 
columns: 

• Key Type — the type of the recovery key that was assigned or created during encryption. The 
possible values are: 

• Unknown — the disk is not encrypted or the disk is encrypted by the Mac user or a third-
party (see the Status column). 

• Personal — personal recovery key. 

• Institutional — institutional recovery key. 

• Status — the current encryption status. The possible values are described in the table below. 

• Volume — the volume name. 

Viewing the FileVault 2 Disk Encryption Report 

In the Configuration Manager console, navigate to Monitoring / Reporting / Reports. Locate the 
FileVault 2 Disk Encryption report and double-click it. The FileVault 2 Disk Encryption dialog 
opens displaying the report.  

Each row in the report represents a corresponding Mac volume and contains the following 
columns: 

• Netbios Name — the Mac netbios name. 

• Volume — the volume name. 
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• Status — the FileVault 2 encryption status (see the table above). 

• Key Type — the recovery key type (Unknown, Personal, or Institutional). 

• Time — the date and time the record was last updated. 

The following table lists all possible FileVault 2 encryption states and transitions: 

State/Transition   Description 

FileVault 2 is Off FileVault 2 is not enabled on the Mac. 

Encryption initiated, waiting for reboot FileVault 2 encryption is in progress. The Mac is about to be 
rebooted to complete the encryption. 

Encryption in progress Encryption is in progress. 

Encrypted The Mac has been encrypted with FileVault 2. 

Decrypting Decryption is in progress. 

Decrypting finished, waiting for reboot Decryption finished. The Mac is about to be rebooted to 
complete the decryption. 

Decrypted The Mac has been decrypted. 

Encrypting in progress by a 3rd party An encryption operation has been initiated on the Mac by the 
user or a third-party program. 

Encrypted by a 3rd party The Mac has been encrypted by the user or a third-party 
program. 

Decrypting (after 3rd party encrypting) 

A decryption operation is in progress. The original encryption 
was performed by the Mac user or a third-party program. The 
decryption has also been initiated  by the user or a third-party 
program. 

Decrypting finished (after 3rd party 
encrypting), waiting for reboot 

The Mac has been decrypted. The original encryption was 
performed by the Mac user or a third-party program. The 
decryption was also performed by the user or a third-party 
program. The Mac is about to be rebooted. 

After Mac computers have been encrypted, the best way for the IT administrator to monitor the 
Mac encryption status is to configure a baseline containing a FileVault 2 configuration item to run as 
often as necessary (e.g. daily). If an unauthorized change is made to the FileVault 2 encryption, the 
baseline run will report an error to Configuration Manager. The IT administrator will be able to see it 
and check the hardware inventory record for a particular Mac. 

Note: You should be aware of one scenario when the FileVault 2 encryption status may not be reported 
accurately in the Mac hardware inventory. This will happen when (a) a Mac is removed from the 
Configuration Manager site, (b) the Parallels Mac Client is uninstalled from it, and (c) the Mac is then 
assigned to the site again. If the Mac was encrypted with FileVault 2 prior to removing it from the site, the 
encryption status will be reported as Encrypted by a 3rd party. To make the status to report accurately, 
you'll need to decrypt the disk and then encrypt it again. 
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To evaluate Mac computers for compliance, you need to add the configuration item to a baseline 
and then deploy it to a Mac collection. See Deploying Configuration Baseline (p. 111) for more 
information. 
 

Using Discovery and Remediation Scripts 

In addition to configuration profiles described in the previous sections, you can assess compliance 
and enforce rules using scripts written in any language supported by OS X.  

To use scripts, you need to create a standard SCCM configuration item in the Configuration 
Manager console. When creating a configuration item, you have an option to specify a discovery 
script and a remediation script. The discovery script is used to obtain the value of a setting on a 
Mac to be assessed for compliance. The remediation script is used to remediate a non-compliant 
value if needed (creating a remediation script is optional).  

When a discovery script returns a value, it is assessed for compliance using the compliance rules 
defined for it. If the value is non-compliance and a remediation script exists, the value is passed to 
the script so that the necessary modifications can be done on the Mac. If a remediation script 
doesn't exist, the assessment stops and a noncompliance is reported to SCCM. Each discovery 
script can assess a single value, but multiple scripts with their own compliance rules can be added 
to a given configuration item. 

This section describes how to: 

• Create a configuration item using the Create Configuration Item Wizard (p. 107) 

• Create a discovery script (p. 109) 

• Create a remediation script (p. 109) 

• Specify the script interpreter to be used (p. 110) 

• Define Compliance Rules (p. 111) 
 

Creating a Configuration Item 

To use scripts to assess compliance, you need to create a standard SCCM configuration item.  

To create a configuration item: 

1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Compliance Settings.  

2 Right-click Configuration Items and then click Create Configuration Item in the context 
menu.  

3 The Create Configuration Item Wizard opens.  

Follow the wizard to create a configuration item as described below. 
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8 When you are finished specifying scripts and compliance rules, click OK in the Create Setting 
dialog and then click Next on the Settings page of the wizard. 

Compliance Rules Page 

The Compliance Rules page lists the compliance rules that you've created earlier. You can review 
and modify them if necessary. You can also create new rules here if needed. Click Next when 
ready. 

Summary, Progress, and Completion Pages 

Review the configuration item summary and click Next when ready. Wait for the configuration item 
to be created. Review the info on the Completion page and click Close to exit the wizard. 

To evaluate Mac computers for compliance, you need to add the configuration item to a baseline 
and then deploy it to a Mac collection. See Deploying Configuration Baseline (p. 111) for more 
information. 
 

Creating a Discovery Script 

A discovery script is specified using the Edit Discovery Script dialog, which is opened from the 
Create Setting dialog, which in turn is opened from the Create Configuration Item Wizard (p. 
107). 

The script can be written in any scripting language supported by OS X, such as Bash, Python, 
Apple Script, etc. See Specifying Script Interpreter (p. 110) for additional information. 

You can type (or copy and paste) the script into the Script edit box. If you have the script saved in 
a file, click the Open button to browse for it.  

A discovery script is used to find and return a value to be assessed for compliance on a Mac. The 
value can be of any data type supported by Configuration Manager, but must be returned by the 
discovery script as a string. Write the script to obtain the value of a desired setting on a Mac and 
return it as a string via standard output.  The returned value is evaluated using the compliance rules 
defined for this configuration item setting. If the value is non-compliance and a remediation script 
exists (p. 109), the value is passed to the remediation script for evaluation. If the remediation script 
doesn't exist, the assessment stops and noncompliance is reported to SCCM. 

Please note that a discovery script will run in OS X with root privileges. Please also note that you 
cannot access OS X GUI components from a discovery script. For example, you cannot open a 
dialog to be displayed to the Mac user. 
 

Creating a Remediation Script 

A remediation script is created using the Create Remediation Script dialog, which is opened from 
the Create Setting dialog, which in turn is opened from the Create Configuration Item Wizard (p. 
107). 
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The script can be written in any scripting language supported by OS X, such as Bash, Python, 
Apple Script, etc. See Specifying Script Interpreter (p. 110) for additional information. 

You can type (or copy and paste) the script into the Script edit box. If you have the script saved in 
a file, click the Open button to browse for it.  

A remediation script is used to remediate non-compliance setting values found on a Mac. The non-
compliance value is passed to the script as an input parameter after obtaining it with the discovery 
script and assessing it using the compliance rules. A remediation script should return 0 (zero) as a 
string via standard output. 

When the remediation script returns, the discovery script is executed again to obtain the updated 
value. The value is then evaluated using the compliance rules. If the value complies, the 
assessment finishes with success. If the value is still non-compliance, a noncompliance is reported 
to SCCM. 

Please note that a remediation script will run in OS X with root privileges. Please also note that you 
cannot access OS X GUI components from a remediation script. For example, you cannot open a 
dialog to be displayed to the Mac user. 
 

Specifying a Script Interpreter 

When creating a discovery or a remediation script, use the syntax described below to specify the 
interpreter that should be used to run it. 

The first line of the script should begin with shebang and have the following format: 

#! interpreter [interpreter-args] <args-list-terminator> [#comment] 

where: 

• interpreter is the absolute path to the interpreter executable (e.g. /bin/bash). 

• interpreter-args is the list of the interpreter arguments. 

• args-list-terminator is the terminating character of the argument list. The terminator is needed 
for passing the result of the discovery script to the remediation script. 

Python example: 

#! /usr/bin/python - 

Bash example: 

#! /bin/bash -- 

• comment is a comment that you might want to add to the script. 
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Creating Compliance Rules 

A compliance rule defines compliance conditions for the value returned by the discovery script. The 
conditions are defined using the Create Rule dialog, which is opened from the Create Setting 
dialog, which in turn is opened from the Create Configuration Item Wizard (p. 107). 

To create a rule, do the following in the Create Rule dialog: 

1 Specify the rule Name and an optional Description. 

2 Set the Rule type to Value. 

3 Use The setting must comply with the following rule section to specify the rule. 

4 If you specified a remediation script for this configuration item setting, you may select the Run 
the specified remediation script when this setting is non-compliance option. If this option 
is selected and the value is non-compliance, the remediation script will be executed and the 
value will be passed to it as a parameter. 

5 The Report noncompliance if this setting instance is not found option affects the 
compliance or non-compliance reporting. When the script execution doesn't fail, but doesn't 
return any data either, the rule is not evaluated. Instead, the compliance status is determined by 
the state of this option as follows: 

• If the option is selected, compliance is reported. 

• If the option is cleared, non-compliance is reported. 

6 Click OK to create the rule and close the dialog. 

You can create more than one rule for a given configuration item setting. If there's more than one 
rule, they will be connected using the logical AND operator. Therefore, for a value to be compliant, 
all rules must evaluate as TRUE. 
 

Deploying Configuration Baseline 

Once you've created one or more configuration items, you need to add them to a configuration 
baseline. Configuration baseline is a container that combines configuration items into a logical unit 
so they can be evaluated for compliance by Mac computers as a group. You can add configuration 
items to an existing baseline or you can create a new one. 

To create a configuration baseline: 

1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Compliance Settings. 

2 Right-click Configuration Baselines and then click Create Configuration Baseline in the 
context menu. The Create Configuration Baseline dialog opens. 

3 Enter the desired configuration baseline name and description. 

4 Click the Add button and then select the configuration items that you want to add to the 
baseline. Click OK and click OK again. 
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To view the Compliance Settings reports: 

1 In the Configuration Manager console, navigate to Site Database / Computer Management / 
Reporting / Reports.  

2 In the report list, find the "Compliance for a computer by configuration item" report or the 
"Compliance for a computer by configuration baseline" report, right-click it and then click Run 
in the context menu. 

3 Specify the report criteria using the provided options (computer name, configuration item 
name). 

4 Click Display to view the report. 

A compliance report contains the basic information about the Mac computer and the configuration 
item (or configuration baseline) together with the following items describing the results of the Mac 
compliance evaluation: 

• Compliance State — describes whether the Mac complies with the corporate policies defined 
in the configuration item(s). The possible values are Compliant and Non-compliant. 

• Last Evaluation Date and Time (UTC) — contains the last evaluation date and time. 
 

Deploying Software via SCCM Package 
Deployment 
The software deployment feature automates the distribution of software to managed Mac 
computers. This Parallels Mac Management feature uses the standard SCCM Package deployment 
functionality. 

Please note that Parallels Mac Management supports Configuration Manager Package and 
Application deployment models. This section describes how to distribute software via SCCM 
Package deployment. For Application deployment, please see Deploying Software via SCCM 
Application Deployment. (p. 118). 

 
 

Creating a Software Package 

A software package is a container for an application, file, or information that need to be applied to 
client Mac computers. A package also includes a program that contains instructions for how the 
contents of the package is to be applied on a Mac.  

You create a package and a program using the standard Create Package and Program Wizard 
in the Configuration Manager console. Once the package is created, you can set additional 
package and program properties that are not available in the wizard. These properties can be used 
to better manage the package installation on a Mac computer.  
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Deploying Software via SCCM Application 
Deployment 
Applications are similar to SCCM packages (p. 113), but contain more information to support smart 
deployment. Parallels Mac Management natively supports the Application Management feature of 
SCCM and allows you to deploy applications on Mac computers. 

The steps to create and deploy a Mac application are: 

1 Choose the installation type (install an application on a Mac silently or interactively) (p. 118) 

2 Prepare a Mac application for Configuration Manager (p. 119) 

3 Create a Configuration Manager application (p. 119) 

4 Configure the Deployment Type (p. 121) 

5 Deploy the application (p. 123) 

The remaining topics in this section describe how the application is installed on a Mac and how to 
use the Parallels Application Portal. 

• Installing Application on a Mac (p. 124) 

• Using Parallels Application Portal (p. 125) 
 

Choose the Installation Type 

When preparing a Mac application for deployment, you can configure it to be installed on a Mac 
silently (transparently to a Mac user) or you can allow the user to interact with the installation 
process. 

Silent Installation 

If you configure the application to install silently, it will be delivered to a Mac and installed without 
giving the user any control over the installation process. The only operation that the user will be 
asked to confirm is restarting the Mac if it is required by a particular application. The options that 
must be set in order to perform a silent installation are highlighted in the corresponding topics 
describing the application deployment steps. 

Interactive Installation 

An interactive installation informs the Mac user that the application is available for installation and, 
depending on the deployment configuration, gives the user full or limited control over the installation 
process. 

When preparing an application for interactive installation, you can specify the following options: 
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• An application can be either required to be installed or the user can be given a choice whether 
to install it or not. 

• The application installer can be displayed on the screen allowing the user to control the 
installation process, or the installer can run in the background thus performing an unattended 
installation. In both scenarios the user can choose whether to run the installer as soon as the 
application is available or to postpone it to a later time. 

The options that must be set in order to perform an interactive installation are highlighted in the 
corresponding topics describing the application deployment steps. 

Parallels Application Portal 

When an application is configured to be deployed interactively as described above, it will be added 
to the Parallels Application Portal on a Mac, which is an OS X application that allows a Mac user to 
view and install applications made available to them by their system administrator. Parallels 
Application Portal is described in detail in the Using Parallels Application Portal section (p. 125). 
 

Prepare a Mac Application for Configuration Manager 

Before you can deploy a native OS X software package (.app, .dmg etc.) in SCCM, you must use 
the CMAppUtil tool to convert it to the .cmmac format that Configuration Manager understands. 

The CMAppUtil tool is provided by Microsoft: 

1 Download the ConfigmgrMacClient.msi file from the Microsoft Download Center using the 
following URL: 

• https://www.microsoft.com/en-us/download/details.aspx?id=47719 

2 Run the downloaded file on your Windows computer to extract the macclient.dmg file. 

3 Copy the macclient.dmg file to a Mac computer. 

4 Double-click the file to see its contents. Extract the Tools folder from the file by dragging and 
dropping it to a folder on your Mac. 

CMAppUtil supports the .dmg, .pkg, .mpkg, .app file formats. 

To convert an OS X application package to the .cmmac format: 

1 Copy the OS X package to the folder where you extracted to Tools folder. 

2 Navigate to the Tools folder and enter the following command-line: 

./CMAppUtil <properties> 

For example, to convert an Apple disk image file named MySoftware.dmg stored in the user's 
home folder to the .cmmac format: 

./CMApputil –c /Users/ <User Name> /MySoftware.dmg -o /Users/ <User Name> 
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• User categories  — click Edit to specify user categories that the users of Parallels 
Application Portal can use to filter and sort the available applications. The Edit button opens 
the User Categories dialog. Select an existing category or click Create to create a new 
category. 

• Icon  — click Browse to select an icon for this application. 

• Display this as a featured app and highlight it in the company portal  — if you select 
this option, the application will be listed in the Featured Applications list in Parallels 
Application Portal. 

3 If the application that you are creating is an upgrade or a replacement for an existing application 
in the Parallels Application Portal, then you can specify a supersedence relationship on the 
Supersedence tab page. Select the Allow users to see deployments for this an all 
applications that it supersedes... option if you want to display all versions of the application in 
the Application Portal. If the option is cleared, only the top application will be shown. 

4 Click OK to close the Properties dialog. 
 

Configure the Deployment Type 

The deployment type for the application is created automatically when you create the Configuration 
Manager application. This section describes some of the deployment type properties that you may 
want to modify. 

To modify the properties of the deployment type: 

1 Select the Deployment Types tab at the bottom of the Applications workspace.  

2 Right-click the deployment type and click Properties in the context menu.  

3 The <application_name> - Mac OS X Properties dialog opens. 

Use the following instructions to modify the deployment type properties as needed. 

Specify the Installation Command Line 

To specify the command that you want to use to install, and optionally uninstall, the application on 
a Mac, click the Programs tab. The Installation program field is used to specify the command 
line. The field is populated automatically and should already contain the installation command for 
the application. You can modify the command line as needed. 

If you've configured the application for the Parallels Application Portal, you can optionally specify an 
uninstallation command for it. This will enable the Remove button in the Application Portal and will 
provide a convenient method for removing an application from a Mac. To add the uninstallation 
command line, use the following syntax: 

:<Installation command>:<Uninstallation command>: 
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To specify the OS X version requirement: 

1 On the Requirements tab page, click the Add button. 

2 In the Category drop-down list, select Device. 

3 In the Condition list, select Operating system. 

4 In the OS X tree, select one or more OS X versions. If you check Select all, all existing and all 
future OS X versions will satisfy the requirement. 

5 Click OK to save the changes and close the dialog. 
 

Deploy the Application 

After you've created the Configuration Manager application and configured the deployment type, 
you need to deploy the application to a Mac collection. 

To deploy the application: 

1 Right-click the application and click Deploy in the context menu. This will open the Deploy 
Software Wizard. 

2 On the General page, click Browse to select the target Mac collection.  

3 In the Select Collection dialog, select Device Collection in the drop-down list, and then select 
the target collection (e.g. All Mac OS X Systems). Click OK. 

4 Click Next. 

5 On the Content page, click Add to add a distribution point that will host this content. Select a 
distribution point and click OK. 

6 Click Next. 

7 On the Deployment Settings page, in the Action drop-down list, select Install.  

8 In the Purpose list, select Available or Required: 

• If you select Available, the application will appear in the Parallels Application Portal on a 
Mac as available for installation, but the user will not be required to install it. 

• If you select Required, the user will be required to install the application. If you want the 
application to be installed silently, you must select this option and also select the Hide in 
Software Center and all notifications option described in step 12 below. 

9 Click Next. 

10 On the Scheduling page, specify the schedule at which this application should be available to 
Mac users. 

If you've selected the application Purpose as Required on the previous page (step 8 above), 
you'll need to specify the Installation deadline for the application. The following deadline 
options are available: 
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• As soon as possible — Mac users will be required to install the application as soon as it is 
available. If a user fails to install the application right away, he/she will be reminded again in 
24 hours. If the application is still not installed after that, it will be installed automatically.  

• Schedule at — Mac users will be required to install the application before the date and time 
specified here. If a user fails to install the application, it will be installed automatically. 

11 Click Next. 

12 On the User Experience page, select a notification type in the User notification drop-down 
list. Depending on the option selected, the following will happen when the application is ready 
to be installed on a Mac: 

• Display in Software Center and show all notifications — The user will be asked to install 
the application and will have an option to start or postpone the installation. If the application 
is configured as Available (i.e. not required, see step 8 above) the user will have a choice 
not to install it. The application will be added to the Parallels Application Portal where the 
user will be able to install it later. The installer graphical user interface will be displayed to the 
user providing full control over the installation process. When the installation is finished, the 
user will be asked to reboot the Mac if necessary. 

• Display in Software Center and only show notifications for computer restarts — This 
option is similar to the Display in Software Center and show all notifications option 
(above) with one exception: the installer will run in the background, so the user will have no 
control over the installation process. The user will still be given a choice to install the 
application or to postpone the installation, and to restart or postpone restarting the Mac if it 
is required. 

• Hide in Software Center and all notifications — The user will NOT be informed that the 
application is available for installation. The installation will be performed completely silently 
and transparently to the user. The application will NOT be added to the Parallels Application 
Portal. If the installation requires Mac restart, the user will be asked to restart it and will be 
given an option to postpone restarting. 

13 Complete the wizard using the default values and close it when done. 

Read on to learn how the application can be installed on a Mac after it's been deployed. 
 

Installing the Application on a Mac 

When the application becomes available for installation on a Mac, the following will happen 
depending on the installation type deployment configuration options. 

Installation is Optional 

If the application is not required (the Deploy Software Wizard | Deployment Settings | Purpose 
is specified as Available), a dialog will be displayed to the user describing the application and 
providing the following choices: 

• Show in Application Portal — Clicking this button will open the Parallels Application Portal 
where the user can view the application and install it if desired. 
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• Install now — Clicking this button will download the application and will run the application 
installer. The installer GUI will be displayed or hidden depending on the setting specified on the 
User Experience page of the Deploy Software Wizard. 

• Close — Clicking this button will close the dialog. The user will be able to install the application 
later from the Application Portal. 

Installation is Required 

If the application is required (the Deploy Software Wizard | Deployment Settings | Purpose is 
specified as Required) and an interactive installation type was specified, a dialog will be displayed 
to the user with the following options: 

Postpone — This button allows the user to postpone the installation. The Remind me in drop-
down list allows the user to select the postponement period. 

Depending on the installation deadline setting (set in the Deploy Software Wizard | Scheduling 
page), the following rules apply: 

• If the policy was downloaded prior to the installation deadline, the deadline will stay in effect. 

• If the policy was downloaded after the deadline has passed, the effective deadline will be set to 
the time of the policy download plus 24 hours. 

Install now — Clicking this button will close the dialog and will run the application installer. 

Installation is Silent 

If the installation type was specified as silent (the Deploy Software Wizard | User Experience 
page | Hide in Software Center and all notifications option was selected), no message asking 
the user to install the application will be displayed, and the installation will be performed silently as 
soon as the policy is delivered to a Mac. 

In all three scenarios above, after the application is installed, the user will be asked to reboot the 
Mac if the installer requires it or if the Action on the User Experience page of the Mac OS X 
Properties dialog is set to force a mandatory restart. 
 

Using Parallels Application Portal 

Parallels Application Portal is an OS X application included in the Parallels Mac Management for 
Microsoft SCCM package. The application is installed on a Mac when Parallels Mac Client is 
installed on it.  
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• Publishers list — Contains the names of software vendors that the user can select to filter the 
application lists. 

• Install button — Displayed for applications that are available for installation. Clicking this button 
will download an application to the Mac and install it. 

• Remove button — Displayed for an application already installed on a Mac. Allows the user to 
remove the application from the Mac. Please note that this button will only be available for 
applications that were configured in Configuration Manager as "Available" (i.e. optional, as 
opposed to required) and for which the uninstallation command line was specified. For more 
info about the installation/uninstallation command line, see Configuring the Deployment Type 
> Specify the Installation Command Line (p. 121). 

 

Operating System Deployment 
Parallels Mac Management provides you with the ability to deploy OS X on Mac computers. To 
deploy OS X on Mac computers, you need to do the following: 

1 Capture an OS X boot image by using the image builder utility included with Parallels Mac 
Management. 

2 Capture an OS X system image using a task sequence or the image builder utility. 

3 Distribute the boot image and the system image to a distribution point. 

4 Create a task sequence that will deploy the OS X system image and optionally execute other 
steps, including: 

• Join Domain 

• Set Hostname 

• Install Package 

5 Deploy the task sequence to a collection of Mac computers. 

6 Boot a Mac from the network and execute the task sequence on it. 

7 When you deploy OS X on a Mac, the task sequence will also automatically install Parallels Mac 
Client on it and will enroll the Mac in SCCM. 

 

Prerequisites for Deploying OS X on Mac Computers 

Before using the OS X Deployment functionality, please verify that the following requirements are 
met: 

• Parallels NetBoot Server must be installed and configured. For details, please see Parallels 
NetBoot Server Requirements (p. 14). 

• If the NetBoot Server and target Mac computers are running in different subnets, DHCP 
forwarding must be set up. For the complete information about setting up the network 
environment for NetBoot, please read the following KB article: http://kb.parallels.com/118518. 
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OS X Software Update Management 
Parallels Mac Management for Microsoft SCCM allows you to manage OS X software updates 
(patches) using the native SCCM functionality. Using this functionality you can import the 
information about available OS X updates into SCCM and then deploy the updates to Mac 
computers in your organization. 

To use the OS X Software Update Management functionality you need: 

• Parallels OS X Software Update Point installed. If you don't have it installed, run the Parallels 
Mac Management installer again and install the component. Before you do, please don't forget 
to read Parallels OS X Software Update Point Requirements (p. 15) and make sure the 
requirements are met or you will not be able to configure Parallels OS X Software Update Point. 

• By default, Mac computers will download deployed OS X updates from Apple's servers. If you 
want to minimize the Internet traffic, you may prefer to host OS X updates on a local server. 
Please note that Parallels Mac Management does NOT include functionality for hosting OS X 
updates. You will have to use the Apple's OS X Server or a third-party software for that. For 
more information, please refer to the documentation that comes with the software of your 
choice. 

 

Configuration Options 

Parallels Mac Management provides you with a number of configuration options that you can use 
to deploy OS X updates to Mac computers. This section describes these configurations. 
 

Download Updates From Apple's Servers 

This is the default and the simplest configuration in which software update catalogs and packages 
are downloaded from Apple's servers over the Internet. The default URL for downloading OS X 
software update catalogs and packages is http://swscan.apple.com/content/catalogs/others/. 

When this configuration is used, OS X updates are installed on Mac computers as follows: 

1 Parallels OS X Software Update Point downloads software update catalogs from Apple's 
servers and then imports them into WSUS. 

2 WSUS is synchronized with SCCM, so the administrator can view and deploy OS X updates 
using the Configuration Manager console. 

3 The SCCM administrator selects which updates they want to install on Mac computers and 
deploys them. 

4 Mac computers download deployed updates from Apple's servers, after which the updates are 
silently installed on them. If an update requires a Mac restart, the Mac user will have a choice to 
postpone the installation. 
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Executing Scripts on Mac Computers 
With Parallels Mac Management you can easily deploy and execute scripts on Mac computers right 
from the Configuration Manager console. This can be helpful, for example, if you have a Mac with 
an issue that can be easily resolved using a script written in Shell or Python.  

A Mac doesn't have to be enrolled in SCCM to deploy a script to it. A connection with a Mac is 
established vis SSH regardless of whether it is enrolled in SCCM or not. 

To deploy and execute a script: 

1 In the Configuration Manager console, navigate to the collection containing your Mac 
computers. 

2 Select a Mac or multiple Mac computers using the Ctrl key, or select the entire collection if 
needed. Right-click the selection and choose Execute Script in the context menu. 

3 The Execute Script On Macs dialog opens. 

4 Browse for and select a script file to be deployed or enter the script into the Edit script box. 

5 Click Next. 

6 On the next screen, specify whether you want to run the script on a Mac with administrative 
privileges and the timeout value. 

7 Click Next. 

8 The next screen allows you to configure an SSH connection. You need to specify a user 
account that should be used to establish a connection with individual Mac computers. You 
have the following choices: 

• Use account from Parallels Mac Client Push Installation properties. With this option 
selected, an SSH connection will be established using the account that you specified in 
Parallels Mac Client push installation properties (p. 60). 

• Use this account. Select this option and then specify an account name and password. 

9 Click Next to deploy the script.  

10 A dialog will open displaying a progress bar (number of processed Mac computers). If a 
connection with a Mac cannot be established, the information about it can be viewed by 
clicking the Details button. The list that opens will contain only the Mac computers that could 
not be reached. You can right-click a Mac in the list for more options, which include viewing 
Mac computers properties and copying the Mac information to the clipboard. 

11 You can click Hide to hide the progress dialog and continue the deployment process in the 
background. To cancel deployment, click Cancel. 
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Apple Device Enrollment Program 
The Apple Device Enrollment Program (DEP) provides a fast, streamlined way to deploy your 
corporate-owned Mac computers purchased directly from Apple or through Apple Authorized 
Resellers. Parallels Mac Management for Microsoft SCCM supports DEP and provides you with the 
ability to automatically enroll new Mac computers in SCCM during the initial device setup 
procedure. 
 

DEP Deployment Overview 

To integrate the DEP functionality into SCCM, you need to configure Parallels Mac Management by 
performing a number of installation and configuration steps. The following list provides you with an 
overview of what these steps are:  

1 Plan for MDM server(s): 

• Decide how many local MDM servers will serve the SCCM hierarchy. One MDM server can 
serve multiple sites, but you can install multiple MDM servers if needed. 

• Ensure that publicly available domain name is reserved for each local MDM server you are 
planning to install and run. 

2 Configure the DEP on the Apple Device Enrollment Program website: 

• Create a virtual MDM server for each primary SCCM site in which you are planning to enroll 
Mac computers. 

• Assign purchased Macs to these virtual MDM servers accordingly. 

3 Install and configuring the following local components: 

• Local MDM server(s) — one or many instances (see step 1 above). 

• Local DEP server(s) — a DEP server is automatically installed when you install the Parallels 
Proxy component on each primary site. 

4 Configure a local DEP service for each primary SCCM site, so it can communicate with the 
Apple DEP. This includes: 

• Uploading server tokens for each primary SCCM site from the corresponding virtual MDM 
servers on the Apple DEP website. 

• Selecting which MDM server will serve the hierarchy of this primary site. 

5 After the DEP is configured, Mac computers associated with Parallels Mac Management 
become visible in the SCCM console of each SCCM site. 

• Parallels Mac Management will periodically (daily by default) update the information about 
the existing and new devices. 

• You can assign Mac computers to secondary sites (if they exist) and if you want them to be 
enrolled on these sites instead of the primary site. 
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Enrolling Mac Computers in SCCM 

After you finish configuring the Device Enrollment Program functionality (as described earlier), your 
Mac computers are ready to be deployed and enrolled in SCCM. 

The procedure consists of the following steps: 

1 When a user starts a Mac for the first time, the Mac connects to the Apple DEP and obtains the 
enrollment profile assigned to it. 

2 The Mac then connects to the Parallels MDM server (which faces the Internet and is accessible 
through it) as instructed by the enrollment profile settings. 

3 The Parallels MDM server registers the Mac in SCCM as a resource. 

4 If an MDM profile was specified in the enrollment profile, then this profile is pushed to the 
registered Mac. 

5 Parallels Mac Client is then installed on the Mac. If the Mac is not connected to your 
organization's network, it will not be enrolled in SCCM at this time. As soon as the Mac is 
connected to the network, Parallels Mac Client will connect to Parallels Proxy and will enroll the 
Mac in SCCM. 

Once a Mac is enrolled in SCCM, you can manage it as any other managed device. 
 

Deploying Parallels Desktop to Mac Computers 
Parallels Desktop for Mac Business Edition is a virtualization software that allows you to run 
Windows and other operating systems on a Mac computer alongside OS X. 

Parallels Mac Management for Microsoft SCCM enables you to deploy Parallels Desktop to Mac 
computers. Deploying Parallels Desktop is similar to deploying other software: you create a 
distribution package, add a program to it, copy the package to a distribution point, and create an 
advertisement (see Deploying Software via SCCM Package Deployment (p. 113)). Parallels 
Desktop deployment adds a few extra steps, which are described below. 

Note: The instructions below describe the Mass Deployment feature, which is only supported by 
Parallels Desktop for Mac Business Edition. Other Parallels Desktop editions do not support it. 

Preparing a Deployment Package 

Parallels provides a special software package that can be used to mass deploy Parallels Desktop to 
many Mac computers at once. 

To prepare the deployment package: 

1 Download the package to your Windows server where the Configuration Manager console is 
running using the following URL: 
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• Description — specifies whether the report was generated automatically or manually by a user. 

If there are no problem reports on the server, the list will be empty. 

To perform an action on a report, select the report of interest from the list and click one of the 
available buttons: 

• Click Send to send the selected problem report to Parallels Support. After the report is sent, it 
is removed from the server on which it resides. 

• Click Delete  to delete the selected report from the list and the server on which it resides. 

• Click Close to closes the dialog. The reports will remain in the problem monitor report list and 
the report files will remain in their original locations. 

Viewing the Problem Report Activity Log 

The problem monitor maintains an activity log, which contains the information about the operations 
that were performed on the reports. To view the problem report activity log, right-click the problem 
monitor icon in the notification area and select Problem Reports Log from the context menu. The 
Problem Report Operations Log dialog opens. Each entry in the log describes an individual 
operation that was performed on a report. This is a read-only information provided as a reference. If 
a report operation included sending it to Parallels Support, the entry will include the report ID, which 
can be used when following up on the report with Parallels Support. 
 

Initiating Policy Retrieval from SCCM 
Managed Mac computers download client policies from Configuration Manager automatically 
according to a schedule. There may be a need to download the latest policy before the scheduled 
download occurs. This is especially helpful when you test or debug something. Policy retrieval can 
be done from an individual Mac computer as described in the Initiating Policy Retrieval from a 
Mac section (p. 74). The functionality described here allows you to initiate policy retrieval for 
multiple Mac computers from the Configuration Manager console. 

To initiate policy retrieval from the Configuration Manager console:  

1 In the Configuration Manager console, navigate to Assets and Compliance / Overview / 
Device Collections.  

2 You can initiate policy retrieval for the entire collection or for selected Mac computers: 

• To select individual Mac computers, double-click the collection containing your Mac 
computers and then select the desired computers. 

• To initiate policy retrieval for the entire collection, simply select the collection without 
opening it (alternately, you can navigate to Overview / Devices and select the collection in 
the left pane). 
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While the collection or individual Mac computers are selected, right-click on them and then click 
Parallels Management Tools > Machine Policy Retrieval and Evaluation Cycle in the 
context menu. 

3 The Requesting Mac Clients to Download Policies dialog opens and the policy retrieval 
initiation operation begins automatically. The progress bar informs you of how many Mac 
computers have been processed.  

4 While the operation is in progress, you can hide the dialog by clicking the Hide button or by 
simply closing the dialog. The policy retrieval operation will continue to run in the background. If 
you want to cancel the operation, click Cancel. 

5 You can initiate another policy retrieval operation while the current operation is still in progress. 
To do so, simply repeat the steps above. Additional Mac computers that you select this time will 
be added to the list of the currently processed Mac computers and the operation will continue 
uninterrupted. 

6 When all Mac computers are processed, you can view the results of the operation by clicking 
the Details button. If the button is disabled, it means that all Mac computers were processed 
successfully. This means that the policy retrieval operation has been initiated on all selected 
Mac computers. If the button is enabled, clicking it displays the list of Mac computers that the 
Parallels Configuration Manager Proxy was unable to connect to. The Status column of the list 
will contain one of the following:  

• Offline — the Mac is turned off or unreachable. 

• Connection refused — the Mac was reachable but the connection was refused by it. 

• No client installed — the Mac doesn't have the Parallels Mac Client installed on it. 

• Not a Mac — the resource is not a Mac computer. 

You can sort the list by Resource Name or Status by clicking the corresponding column 
header. 
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Logging 
Parallels Mac Management maintains its own log files which capture information about its 
processes. The log files are created and maintained for each component including Parallels 
Configuration Manager Proxy, Configuration Manager Console Extension, and clients running on 
individual Mac computers. Some information about Parallels Mac Management processes is also 
recorded in the System Center Configuration Manager log files. You can use the information 
contained in the log files to help you troubleshoot issues that might occur in the Parallels Mac 
Management for Microsoft SCCM.  

Parallels Mac Management for Microsoft SCCM Log Files 

The Parallels Mac Management log files are located in the following directories: 

• Windows computer running Parallels Configuration Manager Proxy: %Windir%\Logs ; 
%Windir%\Logs\pmm 

• Windows computer running Parallels OS X Software Update Point: %Windir%\Logs\pmm 

• Windows computer running Configuration Manager console: %Windir%\Logs 

• OS X (Parallels Mac Client): /Library/Logs/ 

The following table describes the Parallels Mac Management for Microsoft SCCM log files: 

Component Log File Name Log File Description 

pma_setup.log This log file is created during the SCCM Proxy 
installation. It contains information about the 
installation procedures and the changes they 
make to the system.  

Please note that when the SCCM Proxy and 
the SCCM Console Extension components 
are installed on the same computer, the 
pma_setup.log is shared between them. 

C H A P T E R  6  

Appendices 
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pma_isv_proxy_config.log This log file is created and updated every time 
the SCCM Proxy configuration utility is run. It 
contains information about the configuration 
parameters selected by the user (SMS 
Provider, service account name, etc.) and the 
results of the configuration operations. 

pma_isv_proxy_service.log This is the main SCCM Proxy log file. It is 
updated as needed while the SCCM Proxy 
service is running. It contains information 
related to the SCCM Proxy operations such 
as starting/stopping the service, reading 
various system properties, starting or 
stopping Mac management utilities and 
others.  

pma_discovery.log This log file is updated every time the Parallels 
Network Discovery runs. It contains 
information about the discovery itself 
(processes started, subnets searched, etc) 
and the information about discovered Mac 
computers, including IP address, hostname, 
MAC address, whether the Client installation 
was initiated on a Mac, and other info. 

pmm_cep_master_service.log This log file belongs to the Parallels Customer 
Experience Program module. The log is 
updated when the corresponding service 
collects information and generates reports 
about the system. 

Parallels OS X Software 
Update Point 

pmm_sup_service.log This log file belong to the Parallels OS X 
Software Update Point component. it is 
updated when the corresponding service 
performs any of its operations. 

SCCM Console Extension pma_setup.log The SCCM Console Extension component 
has just one log file: pma_setup.log. The file 
contains information about the component 
installation procedure.  

Please note that when the SCCM Proxy and 
the SCCM Console Extension components 
are installed on the same computer, the 
pma_setup.log is shared between them. 

Parallels Mac Client 

 

pma_agent.log This is the main client software log file, which 
contains information about the client 
operations. The file is updated when the Mac 
Client communicates with SCCM Proxy 
and/or performs actions on the Mac 
computer on which it is running. 
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pma_agent_ui.log This log file is updated when the client 
installation and registration utilities are run on 
the Mac by a user.  

The file also records information when an 
operation is performed on the Mac that is 
user-specific. An example of such an 
operation is applying a Mac configuration 
profile (a profile is applied for each individual 
Mac user if more than one user exists). 

Please note that if a Mac user doesn't have 
privileges to write to the /Library/Logs 
directory, the log file will be created in the 
/Users/<user_name>/Library/Logs directory. 

pma_agent_uninstaller.log This log file is created when the client is 
uninstalled from the Mac computer. 

System Center Configuration Manager Log Files 

Some of the Parallels Mac Management process information is recorded in the SCCM log files. You 
may examine these files in addition to the log files described above. Please note that SCCM creates 
these files on the fly and not all of them may actually exist. 

The following table describes the Site Server log files which are located in the 
<SCCM_InstallationPath>\LOGS folder. The files may contain information about the SCCM 
Proxy component.  

Log file Log file description 

Colleval.log Records activities when collections are created, changed, and deleted by the 
Collection Evaluator. 

Dataldr.log Processes Management Information Format (MIF) files and hardware inventory in 
the Configuration Manager database. 

Ddm.log Saves DDR information to the Configuration Manager database by the Discovery 
Data Manager. 

Distmgr.log Records package creation, compression, delta replication, and information 
updates. 

Offermgr.log Records advertisement updates. 

Offersum.log Records summarization of advertisement status messages. 

Policypv.log Records updates to the client policies to reflect changes to client settings or 
advertisements. 

Smsprov.log Records WMI provider access to the site database. 

statesys.log  Records the processing of state system messages. 

The following table describes the Management Point log files, which are located in the 
%ProgramFiles%\SMS_CCM\Logs folder. The files may contain information about the SCCM 
Proxy component. 

Log file Log file description 

MP_CliReg.log Records the client registration activity processed by the management point. 
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MP_Ddr.log Records the conversion of XML.ddr records from clients, and copies them to the 
site server. 

MP_Framework.log Records the activities of the core management point and client framework 
components. 

MP_GetAuth.log Records the status of the site management points. 

MP_GetPolicy.log Records policy information. 

MP_Hinv.log  Converts XML hardware inventory records from clients and copies the files to the 
site server. 

MP_Location.log Records location manager tasks. 

MP_OOBMgr.log Records the management point activities related to receiving OTP form a client. 

MP_Policy.log Records policy communication. 

MP_Relay.log  Copies files that are collected from the client. 

MP_Retry.log Records the hardware inventory retry processes. 

MP_Sinv.log Converts XML software inventory records from clients and copies them to the site 
server. 

MP_SinvCollFile.log Records details about file collection. 

MP_Status.log Converts XML.svf status message files from clients and copies them to the site 
server. 

The following table describes the Admin UI log files, which are located in the 
<SCCM_InstallationPath>\AdminUI\AdminUILog directory. The files may contain 
information about the Configuration Manager Console Extension component. 

Log file Log file description 

ResourceExplorer.log Records errors, warnings, and information about running the Resource Explorer.  

SMSAdminUI.log  Records the local Configuration Manager console tasks when you connect to the 
Configuration Manager site. 

Parallels Mac Management for Microsoft SCCM Crash Dumps 

In addition to log files, crash dumps may be generated if a Parallels Mac Management component 
terminates abnormally. The crash dumps are generated for the Configuration Manager Proxy 
component and for Parallels Mac Clients running on individual Macs. Please note that crash dumps 
may not be created every time a component crashes. If a dump doesn't exist in the directories 
specified below, it can be found in the problem report, which will be generated instead. 

The crash dump file locations are: 

• Parallels Configuration Manager Proxy: 
%ALLUSERSPROFILE%\Microsoft\Windows\WER\ReportQueue\AppCrash_pma_isv
_proxy_*, where AppCrash_pma_isv_proxy_* is the name of a directory containing the 
crash dump files (the name is appended with a unique suffix for each dump). 

• Parallels Mac Client: /Library/Logs/CrashReporter/pma_agent*.crash, where 
pma_agent*.crash is the name of the directory containing the files (the asterisk character is 
substituted with a unique dump identifier). 
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Changing Log File Rotation Limits 

About Log File Rotation 

Parallels Mac Management for Microsoft SCCM implements log file rotation that ensures that the 
log files don't grow in size indefinitely. The amount of data contained in an individual log file and the 
total size of all logs are kept at a reasonable limit. Log file rotation is enabled by default.  

Parallels Mac Management for Microsoft SCCM consists of a number of executables including 
services, graphical user interface, and utilities. Each executable creates its own log file named 
<exec_name.log>, where "exec_name" is the executable file name. The following table lists 
Parallels Mac Management executables and their corresponding log file names and locations: 

Executable Name Operating System Log File Name and Path 

pma_isv_proxy_service Windows %Windir%\Logs\pma_isv_proxy_service.log 

pma_isv_proxy_config Windows %Windir%\Logs\pma_isv_proxy_config.log 

pma_discovery Windows %Windir%\Logs\pma_discovery.log 

pmm_cep_master_service Windows %Windir%\Logs\pmm\pmm_cep_master_service.log 

pmm_sup_service Windows %Windir%\Logs\pmm\pmm_sup_service.log 

pma_problem_monitor Windows %Windir%\Logs\pma_problem_monitor.log 

pma_report_tool 
Windows 

OS X 

%Windir%\Logs\pma_report_tool.log 

/Users/<user_name>/Library/Logs 

pma_agent OS X  /Library/Logs/pma_agent.log 

pma_agent_ui OS X /Library/Logs/pma_agent_ui.log 

A log file is populated with data when an executable is running and performing its tasks. When the 
size of a log file exceeds a predefined limit, the file is archived and a new empty log file is created in 
its place. This creates a log file rotation set consisting of the current log file and archived files. A log 
file rotation set is managed using the following rules: 

• Log files are archived using the zlib compression library. 

• The archived files in the set are named as follows:  

<exec_name.1.log.gz>, <exec_name.2.log.gz>, <exec_name.3.log.gz>, etc.  

The <exec_name.1.log.gz> file is the most recently archived log segment. The file with the 
largest sequential number in its name is the oldest. When the current log file is archived, it is 
named <exec_name.1.log.gz>. The existing archives are renamed by incrementing the 
sequential number in their names by 1. The maximum number of files in a rotation set can be 
configured (see Changing Log File Rotation Limits below). When the number of files exceeds 
the predefined limit, the oldest file is deleted. 

• Rotation of each log is performed independently from other logs. 
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Changing Log File Rotation Limits 

Log file rotation limits are configured similarly on both Windows and OS X computers. The following 
rules apply when specifying the limits: 

• Log file size limit. The default value is 1 MB (specified in bytes). The minimum allowed value is 
200 KB. The maximum allowed value is 4 MB. If a value is not set, the default value is used. If 
the specified value falls outside the min/max interval, the minimum or the maximum value is 
used respectively. 

• Maximum number of files in a rotation set. The default value is 10. The minimum value is 1. 
The maximum value is 20. If a value is not set, the default value is used. If the specified value 
falls outside the min/max interval, the minimum or the maximum value is used respectively.  

On Windows computers the log rotation limits are stored in the system registry. To modify the 
limits: 

• Run "regedit" and search for HKEY_LOCAL_MACHINE\SOFTWARE\Parallels\Parallels 
Management Suite for Microsoft SCCM\Preferences. 

• To set the log file size limit, modify the value of the "LogFileSizeLimit" parameter. The size is 
specified in bytes. 

• To set the maximum number of files in a rotation set, modify the value of the 
“MaxNumberOfSavedLogs” parameter.  

On OS X computers, the log rotation limits are stored in the 
/Library/Preferences/com.parallels.pma.agent.plist file. To modify the limits: 

• Open the com.parallels.pma.agent.plist file in a text editor. 

• To set the log file size limit, modify the value of the "LogFileSizeLimit" parameter. The size is 
specified in bytes. 

• To set the maximum number of files in a rotation set, modify the value of the 
“MaxNumberOfSavedLogs” parameter. 

 

Parallels Mac Management Database 
When Parallels Mac Management for Microsoft SCCM is installed, it creates its own SQL Server 
database on the primary SCCM site to store security data such as recovery keys, certificates, and 
other.  

The database name is constructed using the following syntax: 

PMM_<site_name> 

Where, PMM_ is used as-is and <site_name> is the name of the primary SCCM site. 
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At the time of this writing, the database is used to store the FileVault 2 disk encryption information 
and recovery keys. Other security related data may be stored in the database in the future. 

The system administrator should backup the database regularly in order to ensure the data safety. 
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